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Preface

This guide describes the Oracle Retail Predictive Application Server Cloud Edition 
user interface. It provides step-by-step instructions to complete most tasks that can be 
performed through the application.

Audience
This User Guide is intended for retailers and analysts.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support 
through My Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related Documents
For more information, see the following documents in the Oracle Retail Advanced 
Science Cloud Services documentation set:

■ Oracle Retail Predictive Application Server Cloud Edition Online Administration Guide

■ Oracle Retail Predictive Application Server Cloud Edition Configuration Tools Guide for 
Developers

■ Oracle Retail Predictive Application Server Cloud Edition Release Notes 

Customer Support
To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following:

■ Product version and program/module name

■ Functional and technical description of the problem (include business impact)



xiv

■ Detailed step-by-step instructions to re-create

■ Exact error message received

■ Screen shots of each step you take

Improved Process for Oracle Retail Documentation Corrections
To more quickly address critical corrections to Oracle Retail documentation content, 
Oracle Retail documentation may be republished whenever a critical correction is 
needed. For critical corrections, the republication of an Oracle Retail document may at 
times not be attached to a numbered software release; instead, the Oracle Retail 
document will simply be replaced on the Oracle Technology Network Web site, or, in 
the case of Data Models, to the applicable My Oracle Support Documentation 
container where they reside.

This process will prevent delays in making critical corrections available to customers. 
For the customer, it means that before you begin installation, you must verify that you 
have the most recent version of the Oracle Retail documentation set. Oracle Retail 
documentation is available on the Oracle Technology Network at the following URL:

http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html

An updated version of the applicable Oracle Retail document is indicated by Oracle 
part number, as well as print date (month and year). An updated version uses the 
same part number, with a higher-numbered suffix. For example, part number 
E123456-02 is an updated version of a document with part number E123456-01.

If a more recent version of a document is available, that version supersedes all 
previous versions.

Oracle Retail Documentation on the Oracle Technology Network
Oracle Retail product documentation is available on the following web site:

http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html

(Data Model documents are not available through Oracle Technology Network. You 
can obtain these documents through My Oracle Support.)

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.

http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html
http://www.oracle.com/technetwork/documentation/oracle-retail-100266.html
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1Getting Started 

Welcome to Oracle Retail RPAS Cloud Edition (RPASCE). This chapter provides an 
overview that includes information to help you get started with the application. 

Overview
RPASCE is a configurable cloud-engineered platform with a proven scalability for 
developing multidimensional forecasting and planning-based solutions with an 
enhanced user experience. The RPASCE client is a web-based platform developed 
using the latest Oracle JavaScript Extension Toolkit (OJET). 

Planning is one of the most important and complex processes in a retail business. It 
typically involves a set of activities that must be followed as part of a workflow. The 
RPASCE Client includes an Activity Task Flow feature that provides a robust 
workflow that makes each planning activity easier to track and maintain.

Essential Concepts
RPASCE is a configurable platform with a proven scalability for developing 
multidimensional forecasting and planning-based solutions. This platform provides 
capabilities such as a multidimensional database structure, batch and online 
processing, a configurable slice-and-dice user interface, a sophisticated configurable 
calculation engine, user security, and utility functions such as importing and 
exporting, all on a highly scalable technical environment that can be deployed on a 
variety of hardware.

This section describes the basic concepts of RPASCE.

Multidimensionality
In RPASCE, information is stored and represented based on a multidimensional 
framework. In a multidimensional database system, data is presented as a 
multidimensional array, where each individual data value is contained within a cell 
accessible by multiple indexes. 

Multidimensional database systems are a complementary technology to entity 
relational systems and achieve performance levels above the relational database 
systems. Applications that run on RPASCE identify data through dimensional 
relationships. Dimensions are qualities of an item (such as a product, location, or time) 
or components of a dimension that define the structure and roll up within the 
dimension.
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Dimensions, Levels, and Positions
Dimensions describe the top-to-bottom relationship between the levels or positions of 
the dimensions in RPASCE. They reflect the dimensions set up at your business and 
used by the merchandising solutions.

RPASCE supports many alternative dimensions that provide different roll ups and can 
help you analyze the data from differing perspectives.

Measures
Measures represent the events or measurements that are recorded, while the positions 
in the dimensions provide a context for the measurement. Measures are defined based 
on the business rules set in the application. The dimensionality of a measure is 
configured through the definition of its base intersection, which is the collection of 
levels (one per appropriate dimension) defining the lowest level at which the 
information is stored for the measure.

Measure names are completely configurable and typically named using a convention 
that identifies each component and the meaning of the measure.

Cells
Cells contain the data or values where the positions and measures intersect with the 
levels of the dimensions.

Workspaces and Domains
RPASCE stores information in a persistent multidimensional data cache that is 
optimized for large volumes and dimensional or time series data access requirements, 
typically required by multidimensional solutions. This central repository is called a 
domain. The domain also includes central definitions of metadata for the solution and 
provides a single update point.

When you use an RPASCE solution, you interact with the solution through a personal 
data repository called a workspace. A workspace contains the subset of the data (and 
metadata) from the domain, and its scope is constrained by the access rights available 
to a user. Workspaces are stored on the RPASCE server and can be built using an 
online wizard process or scheduled to be built in a batch process automatically.

Although the data and metadata in the workspace are copied from the domain, the 
data remains independent of the domain.

With a solution task-flow, you are logged into a solution. When you pick a particular 
task, you are directed to build a segment. Based on the selection, the segment is 
created and can only access the data that was selected while building the segment. 
User position level security is also considered during this process and displays only 
the data you have access to.

Dashboard
The profile-based dashboard with summary KPI tiles that help user to focus on what 
needs attention. The profiles are tailored to the role and business process (for example, 
Admin, Pre-Season, In-Season, and Exception) with summary KPIs and detailing the 
KPIs in a visual representation using dynamic charts. You can easily personalize the 
Dynamic Hierarchy layout and access the recent plans that you have worked on.
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Dynamic Hierarchy
The dynamic roll-up of store to cluster in a workspace depends on the product 
dimension and it can be done without rebuilding the workspace. Note that, for a 
particular product department, a store can change from a high volume store to a 
medium volume store cluster. This refresh can be triggered using a custom menu. The 
refreshing of the dynamic hierarchy does not require the refreshing of the entire 
workspace.

Setting Up Your Browser
The RPASCE Client can be accessed using Microsoft Internet Explorer, Google 
Chrome, or Mozilla Firefox. Before you access the application for the first time, you 
must set the following browser settings to allow seamless and error-free access.

■ Cache settings

■ Security settings

Cache Settings
The RPASCE Client can leverage the browser cache for a better experience. However, it 
is recommended that you clear the browser's cache periodically so that temporary 
internet files are deleted, especially with version updates. The cache settings are 
typically found in the browser's tool menu.

Security Settings
Ensure that JavaScript and Cookies are enabled on your browser. These may be the 
default settings in most cases; if not, ensure that this is the case using the following 
steps.

On Chrome, click Customize and Control Google Chrome button in order to access 
Settings->Privacy-> Content Settings.

Figure 1–1 Chrome Content Settings

On Firefox, to check or change your settings, complete the following steps:
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1. Click the Tools drop-down list button and select Options.

2. Select the Privacy panel.

3. Check for History.

Figure 1–2 Privacy

By default, Firefox enables the use of JavaScript and requires no additional setup.

If using Internet Explorer, you must configure the browser security settings to improve 
the user experience. To set the security settings, complete the following steps: 

1. Start Internet Explorer.

2. From the Tools menu, click Internet Options. 

3. On the Security tab, click Local intranet, and then click Sites.

Figure 1–3 Internet Options

4. On the Local intranet window, click Advanced. 

5. In the Add this website to the zone field, enter the application URL, click Add, and 
then click Close.
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6. On the Local intranet window, click OK. 

7. In the Security level for this zone area, click Custom level....

8. Click Enable for Active Scripting in the Scripting section.

9. After you set up these parameters, click OK. A message appears that prompts you 
for a confirmation of the changes to the settings for the zone. 

10. Click Yes to accept the changes. Based on the settings you changed, you may need 
to restart Internet Explorer for the changes to take effect.

Similarly, make sure cookies are enabled on IE. Select the Privacy tab, and under 
Settings, select Advanced and make sure you have first party cookies and third party 
cookies selected.

Logging Into RPASCE
This section details the available logging scenarios.

Before you log into RPASCE, ensure that your system meets the recommended 
configuration requirements.

After you check the configuration, obtain the following information:

■ Uniform Resource Locator, URL: Enter or click the application URL in the web 
browser or shortcut provided by your Administrator to access the application. For 
example:

http://<fullyqualifieddomainname>:<port>/context root

■ User name and Password: Based on the tasks you want to perform, obtain a user 
account (that includes user name and password) to log into the application. Once 
logged into the application, log in with Username and Password for notifications. 

What you see when logging in depends on the type of external authentication used. 
The RPASCE login page appears only when you use Oracle Access Manager (OAM) 
for authentication. 

To log into the RPASCE:

1. Open a supported internet browser.

2. In the Address bar, enter the RPASCE URL and click Enter. 

3. Enter the Username and Password details and click Log In.

4. If the notification server login is required, enter the notifications username and 
password after logging into the application. Enter the notification login details.

The RPASCE Home page appears.
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Figure 1–4 RPASCE Home Page

With Single Sign-On, the Single Sign-On login page is displayed. If you are using 
Single Sign-on (SSO), you may select a link in a portal and then see the home page.

Figure 1–5 Login Window

The RPASCE Login page appears.

Logging in Using Single Sign-On
If you have accessed the RPASCE through a single sign-on environment, you see the 
home page of the RPAS CE.

Note: For more information about single sign-on (SSO), see the 
Oracle Retail Predictive Application Server Cloud Edition Online 
Administration Guide.

Concurrent Sessions
If you already have a user session for RPASCE running, you can start a second or 
concurrent session at the same time. This can be a private/incognito window in the 
same browser or a different browser. When logged into RPASCE, if you have a 
concurrent session running, you see the following message:
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Figure 1–6 Concurrent Sessions

Select one of the following options:

■ Create another session (All existing connections will be left open): This option 
allows the user to have multiple connections. This does not affect any prior user 
connections.

■ Close all existing connections and create a new one. (Any unsaved changes will be 
lost): This option closes any existing connections for the user and opens a new 
connection.

Note: For information about the number of allowed concurrent 
sessions, see the Oracle Retail Predictive Application Server Cloud Edition 
Online Administration Guide.

Comparative Analysis
You can use the comparative analysis feature to open multiple segments in such a way 
that you can view them at the same time and work on them in parallel.

You can launch the view in a separate browser tab in order to do comparative analysis. 
When you want to do such an analysis, you can go to the recent plans pane and click 
the launch icon next to the segment name. The secondary tab will not have all the 
menu options that the primary window has. 

You can only launch and view the single segment in the separate tab. You can navigate 
through various views in the workspace. However, you cannot navigate between 
different workspaces; you must close the tab and launch a separate workspace.
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Figure 1–7 Comparative Analysis

You can compare the views in the concurrent login sessions. This view is almost 
similar to the earlier one, except that in the second login you have access to all the 
features of RPASCE. You are not limited to comparing the one workspace that you 
opened; you can switch between workspaces, bring up other segments, and conduct 
separate planning processes using the secondary login.

Figure 1–8 Compare Views in Concurrent Login Sessions

Understanding the Taskflow
Click Menu or Tasks to display the taskflow. You can use the taskflow to navigate 
through the activities in the application. It provides a pre-configured business 
workflow organized into expandable and collapsible activity groups, activities, tasks, 
steps and substeps.

Each activity consists of more than one task and each task may consist of one or more 
steps. In RPASCE, each solution (spanning across multiple workbooks) is represented 
as a set of activities, tasks, steps and substeps. The activities can also be grouped into 
an activity group.
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Figure 1–9 Tasks

In the taskflow, you can click the icon next to any task to view the associated steps and 
substeps.

Click on specific task to view the steps associated under the task.

Figure 1–10 Administration Tasks

When you are working with a specific step, click on the icon to display the available 
substeps. 
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Figure 1–11 Task Substep

Access-Based Visibility
The activities and tasks that appear in the taskflow are access-based. Depending upon 
the security settings, you may not have access to some tasks or activities. Access to a 
task is defined by whether you have access to the workbook template that the task is 
assigned to. 

The access to the workbook template is maintained in the Security Administration 
step. See the Oracle Retail Predictive Application Server Cloud Edition Online 
Administration Guide for more information about the Administration activity. If you do 
not have access to a workbook template, then you cannot build the workbooks for the 
associated tasks and steps.

If you do not have administrator access, the Administration activity does not appear in 
the taskflow.

Figure 1–12 Task Access

Switching Between Multiple Tasks
When working within multiple steps or tasks, all changes you make in a specific step 
are maintained when you move to a step in the same task or a different task associated 
with the same workspace. In such cases, you do not need to save your work when you 
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switch between tasks within the same or different workspaces. RPASCE has an 
exclusive Auto-Save option when any calculation or action is performed on the 
workspace. 

Workspace Operations
The workspace provides you a the personal working copy of data. You can perform 
large-scale operations such as build, open, refresh, calculate, and commit. Use the 
workspace to sort, find, format, lock, unlock, and scroll through the page edges. 

Locating the Version Number
Click the Question Mark in the top right and select About Application to access the 
Version Number and other information.

Figure 1–13 Accessing About Application

Accessing Online Help
Click the Question Mark in the top right, as shown in Figure 1–13. Select Application 
Help to access the online help.

Logging Out of the Application
Click the user name in the top right and select Logout.

Figure 1–14 Logout
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2User Interface 

This chapter introduces you to the user interface for the workbook and describes the 
screen components labeled in Figure 2–1.

Figure 2–1 User Interface

Here is the key to the figure labels.

1. Left Sidebar Menu

2. Mega Menu

3. Quick Access Toolbar

4. Content Area

5. View Management

6. Action Buttons

Left Sidebar Menu
The Left Sidebar menu contains the following options:



Left Sidebar Menu

2-2 Oracle Retail Predictive Application Server Cloud Edition User Guide

■ Task Module

■ Notifications

■ Reports

Task Module
The Task Module provides access to the Segments dialog box that you use to open 
existing workspaces or create new workspaces to complete the different tasks per role. 

Figure 2–2 Task Module

Notifications
You can use the Notifications module to determine the status of different RPASCE 
activities, such as Online Administration Tasks, segment build completions or failures, 
segment commit completions or failures, approvals and rejections, and so on.

Figure 2–3 Notifications
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Reports
You can use the Reports module to view the reports or dashboards available with in 
the application.

Figure 2–4 Reports Module

Mega Menu
Once a task or workspace is open, you can use the Mega Menu to access the different 
workflow steps for each task.

You can move between the different steps within a task without reopening a segment 
or going through the wizard process again.

Each step has different views to choose from in the View Manager on the right side of 
the screen. You can use each view to complete a different type of activity.

Figure 2–5 Mega Menu

Help
To access the Help menu, click the Question Mark in the top right. Select Application 
Help to access the online help.
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Figure 2–6 Online Help

Quick Access Toolbar
The Quick Access toolbar contains Menu, Calculate, Find, Export, Real Time Alert 
Exceptions List, Text Size, and Manage Views. These are all described in this section.

Figure 2–7 Quick Access Toolbar

Menu
Menu contains the following menu options:

■ Action menu

■ Edit menu

■ View menu

■ Format menu
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Figure 2–8 Menu Options

Table 2–1 lists the options within each menu.

Table 2–1  Toolbar Menu Options

Menu Submenu Sub-Submenu

Action Commit

Refresh

Edit Calculate

Find

Lock

Unlock

Unlock All

View View Layout Full View

2x Horizontal

2x Vertical

4x Tiled

Synchronize Z Axis

Format Edit Styles and Exceptions

Save Format Only For Me

For My Group: 
Administrators

Delete Format Only For Me

For My Group: 
Administrators

Action Menu
This section describes the Action Menu options.
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Figure 2–9 Action Menu

Table 2–2  Action Menu Options

Menu Option Description

Commit (F8) Use to commit the changes to the master domain. After the 
changes are committed, all other users with access to the 
workbook will see the changes as well.

Refresh (Ctrl + R) Use to update a workspace with the data that is currently stored 
in the domain. This allows you to work with the most current 
data without having to rebuild the workspace. Workspaces can 
be refreshed with a single refresh rule group or multiple ones

Edit Menu Options
This section describes the Edit Menu options.

Figure 2–10 Edit Menu



Table 2–3  Edit Menu Options

Menu Option Description

Calculate (F9) After you edit the cells within the workspace, use the Calculate 
icon to calculate and update the associated cells within the 
workspace.

Find Use to search for phrases within the rows, column, and page axis 
of an active view. The search does not include the data within 
the view.

Lock Protects cells, measures, and positions from being edited. For 
more information, see "Locking and Unlocking".

Unlock Use to remove the protection of cells, measures, and positions so 
that they can be edited. For more information, see "Locking and 
Unlocking".

Unlock All Use to remove the protection from all cells, measures, or 
positions so that they can be edited. For more information, see 
"Locking and Unlocking".
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View Menu
This section describes the View Menu options.

Figure 2–11 View Menu



Table 2–4  View Menu Options

Menu Option Description

View Layout Full View - Maximizes a single view to cover the entire contents 
area.

2X Horizontal - Aligns two views one above the other 
horizontally.

2X Vertical - Aligns two views side by side vertically.

4X Tiled - Aligns four views with one view in each corner of the 
contents area.

Synchronize Z Axis Use to simultaneously scroll through the page edge of multiple 
views. It is useful when you want to compare multiple views 
containing the same page or slice dimension.
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Format Menu
This section describes the Format Menu options.

Figure 2–12 Format Menu

Table 2–5  Format Menu Options

Menu Option Description

Edit Styles and Exceptions Opens the Format dialog box. In the Format dialog box, you can 
set and clear formats that apply to measures or dimensions. You 
can make changes to single or multiple measures and 
dimensions and apply those changes across one, many, or all 
views in the workspace. For more information, see Chapter 10, 
"Formatting.".

Save Format Only For Me

For My Group: Administrators

Delete Format Only For Me

For My Group: Administrators



Quick Access Toolbar

User Interface 2-9

Calculate Button
After you edit the cells within the workbook, use the Calculate button to calculate and 
update the associated cells within the workspace. You can also access this option from 
the Edit menu. 

Figure 2–13 Calculate Button

Find Button
You can use the Find button to find any specific string with either As-Is or Match case 
or Whole word. You can also choose to search the string in all views or selected views 
of the workspace or all dimensions or specific dimensions available in the workspace. 

Figure 2–14 Find Button

Export Button
You can use the Export functionality to export slices of data to a text file or to a         
Microsoft Excel file by using different format and export options. You can print data to 
an Excel spreadsheet using the Print option in the Export dialog box.
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Figure 2–15 Export Button

Real Time Alerts Exceptions List
Real time alerts are interactive alerts that are displayed when you open a workbook or 
view. The alerts are then updated each time you edit data and click Calculate. The 
alert count summary is displayed along with the capability to know more information 
as and when needed. Clicking on > launches the alert navigation mode.

Figure 2–16 Real Time Alerts Exception List

Text Size
Once in an open workspace, click Text Size on the top right and select a text size. This 
allows you to control how much data is displayed on a screen at one time.

Figure 2–17 Text Size



Content Area

User Interface 2-11

Manage Views
Click Manage Views to display the view management drawer. It allows you to show 
or hide the view management drawer if you need more area to view the content.

Figure 2–18 View Management Drawer: Show

Figure 2–19 View Management Drawer: Hidden

Content Area
The content area appears on the center of your screen and includes the views 
associated with each step within the business workflow. It provides a spreadsheet-like 
view or a chart type view that display multidimensional data selected at the 
dimension levels in Edit view. Each view includes a set of measures relevant to the 
step that help you view, analyze information, and make decisions. 

Figure 2–20 shows the various components in the content area.
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Figure 2–20 Content Area

Table 2–6 describes the Content area.

Table 2–6  Content Area

Legend Area Description

A View Title Bar Displays the name of the view and includes 
view-level features such as Edit, Expand, 
and Close View Options. 

B Page Edge and Dimension Tiles Area Use to move or swap individual 
dimensions to view the information in a 
more effective manner. See Page Edge and 
Dimension Tiles Area.

C View Area Displays the data either in a pivot table 
view or a graphical view with the help of 
different chart types. The data represented 
here is at the dimension levels and axes 
selected in the Page Edge and Dimension 
Tiles area.

Page Edge and Dimension Tiles Area
This area displays all the dimensions involved in the view. The information in the 
view is organized based on the dimension positions set up at the page edge, row, and 
column axes. 

The RPASCE Client is designed to help you to work with the easy selection of 
dimension levels within the Edit view. You can manage the way the information is 
presented in a view. You can arrange and present the information in a layout you want 
by rotating or pivoting dimensions across the axes, changing the data roll ups and 
measure profiles and showing or hiding measures. You can view the information at a 
low level of detail or aggregate to view the information at summary levels. 

Figure 2–21 Page Edge and Dimension Tiles Area
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Pivoting and Rotating Dimensions
In the View area, you can rotate or pivot the dimensions across the axes to display data 
in different orientations. You can pivot the dimensions in two ways.

■ Dimension Move: Moves a dimensional layer to another position on an axis.

■ Dimension Swap: Swaps a dimension with another dimension on the axis.

To perform a dimension move, in the Dimension Tile Area click and hold the 
dimension tile you want to move. Then, drag the tile next to the area you want and 
release the mouse.

Figure 2–22 Dimension Move

To perform a dimension swap, in the Dimension Tile Area, click and hold the 
dimension tile you want to move. Then, drag the dimension tile over the one you want 
to swap it with and release the mouse.

Figure 2–23 Dimension Swap

Paging and Position Navigation
On the Page Edge area, you can select any position displayed and page through or 
navigate to the positions using the navigation icons (Previous, Next, Select Position) 
available below the dimension tiles. In the view, data relevant to each position is 
displayed in the content area when you navigate to a new position in a level.
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Figure 2–24 Position Navigation

Use the Previous and Next icons to navigate to the previous and next position in the 
level that is selected. The position to which you navigate depends on the current 
position. When you navigate to a new position, all associated positions at the higher 
and lower visible levels of the same dimension are updated recursively.

The Select Position icon opens a Select Position popup, which you can use to directly 
select the required position from the available list of positions.

Figure 2–25 Select Position

Edit View
Using the Edit View dialog box, you can change the way data is presented to you by 
moving and reordering the dimension tiles, selecting the dimension levels for the data 
rollups, and selecting the measure profiles. 

Synchronize Z Axis Scrolling
Synchronized Z Axis scrolling lets you simultaneously scroll through the z axis of 
multiple views. When Synchronized Z Axis scrolling is enabled, all views that contain 
the same slice dimension scroll to the new slice position when one of those views is 
scrolled to a new position. When scrolling is disabled, scrolling through slice positions 
in one view does not affect the slice position display of other views.

Synchronized Z Axis scrolling works for all views within a single workspace, and it 
remains enabled as you move through the tasks and steps within that workspace. 
Synchronized Z Axis scrolling is useful when you want to compare multiple views 
containing the same page or slice dimension.

To enable synchronized Z Axis scrolling, click Synchronize Z Axis in the z axis and 
Dimension Tiles area, as shown in Figure 2–27.
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Figure 2–26 Before Synchronizing Page Edge

Figure 2–27 Enabling Synchronize Z-Axis

View Management Drawer
The View Management Drawer shows the different views available for the tasks and 
steps. You can drag an existing view into the Content area to activate that view. You 
can choose to display one, two horizontal, two vertical, or four views at one time to 
view in the content area. You can also click Plus to create a new view, modify an 
existing view, or delete an existing view.
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Figure 2–28 View Management Drawer

Action Tray
The Action Tray includes Application Actions and System Actions. Application actions 
are specific to different applications configured in RPASCE. System actions are 
common across all the views, irrespective of the application.

Examples of Application Actions include Seed, Refresh Fulfillment, Submit Plan, 
Approve Plan, Copy Approved Plan, and so on in MFP R CS and Seed Sales, Calculate 
What-If, Copy Linked Items, Flow Receipts, Approve Plan, and so on in IP CS. 
Application Actions are highlighted in red in Figure 2–29 and Figure 2–30.

The System Actions include Calculate, and Commit. System Actions are highlighted in 
green in Figure 2–29 and Figure 2–30. As you can see, they are common across 
different applications, in this example across both MFP R CS and IP CS.

Figure 2–29 Example of Application Actions and System Actions in MFP R CS
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Figure 2–30 Example of Application Actions and System Actions in IP CS
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3Dashboards 

The RPASCE Dashboard is the central page of any RPASCE-based product. It is the 
first page that you see after logging into the application. It can be used to locate issues 
that need attention. It can also be used for data analysis, allowing you to examine your 
data at any scale and for any time frame. In addition, the dashboard can be used to 
open your most recently used workspaces with a single click. 

The dashboard must be refreshed periodically, as new products, locations, and so on, 
are added. This typically happens weekly, but depends on the nature of the RPASCE 
application. Measure information in a dashboard can be refreshed at any time.

Figure 3–1 highlights the different section in the dashboard.

Figure 3–1 Dashboard

Tiles
Dashboard information comes packaged in metric tiles. These tiles are arranged at the 
top of the dashboard on a carousel (a set of components that can scroll horizontally).
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Figure 3–2 Example Metric Tile

There are several styles of metric tiles. Figure 3–2 represents a variance tile. A variance 
tile shows the variance between one quantity and two others. Some tiles can represent 
information. An informational tile just displays the existing measure data.

Every tile has certain common characteristics. For example,

■ A title. In Figure 3–1 and Figure 3–2, Wp GM R is the title.

■ An aggregate quantity. In Figure 3–1 and Figure 3–2, 29.3 (Million) and 9.6% and 
0%. This number reflects the filter selections.

■ A color state and icon. In Figure 3–1 and Figure 3–2, Wp GM R is shown in a red 
octagon (indicating a problem) because the working plan value is 9.6% below the 
Last Year value. 

The colors indicate the following states: red = critical, yellow = important, green = 
normal, blue = no severity, and grey = administration.

Figure 3–3 Tile Showing Color State and Icon

■ An informational tile, shown in Figure 3–4, is always green (indicating no 
problem) because it is simply shows the measure. 

Figure 3–4 Informational Tile
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■ A yellow triangle tile, shown in Figure 3–5, represents an exception with 
Important Severity.

Figure 3–5 Yellow Triangle Tile Representing Important Severity

■ A Blue Circle tile, shown in Figure 3–6, represents an exception with No Severity.

Figure 3–6 Blue Circle Tile Representing No Severity

The arrow beneath a tile, shown in Figure 3–7, indicates that this measure is displayed 
in the chart area in more detail. Clicking on a different tile refreshes the data in the 
chart area and places the arrow under the clicked tile.

Figure 3–7 Variance Tile
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Metric tiles must represent the basic quantities that are used to indicate the health of 
your business. An implementer can create new metric tiles, modify existing ones, or 
delete tiles entirely.

Adding a New Tile
You can add a metric tile from an existing pool of tiles. To add a new tile, click Plus on 
the right hand side of the metric tile carousel (some scrolling may be required). 

Figure 3–8 Add New Tile

This brings up a dialog box showing all available metric tiles. Click the desired tile and 
click OK. The tile is added to your tile carousel.

Figure 3–9 Available Metric Tiles

Changing the Display Order
You can change the order in which tiles are displayed. To do this, the metric tile 
carousel must be in edit mode. To access edit mode, click Edit Dashboard under the 
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Plus icon to the far right of the carousel. Once in edit mode, each tile displays a drag 
bar at the bottom of the tile. You can drag the tile to the place you want it on the 
carousel and drop it.

Figure 3–10 Changing the Display Order

Removing a Tile
To remove a tile, enter edit mode by clicking the Edit Dashboard. In addition to the 
drag bar, each tile also displays a Delete icon in the upper right corner. Click Delete to 
remove the measure. Note that the measure can still be added from the metric tile 
pool.

All changes to the metric tile carousel are automatically remembered by RPASCE. The 
system remembers the desired order and content until you change it.

Figure 3–11 Removing a Tile

Main Chart
Selecting a tile displays detailed information for the measures represented by the tile 
in the main chart area. The information is presented with time on the horizontal axis 
and the measure quantity on the vertical axis.
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Figure 3–12 Main Chart

Modifying the Chart Type
Click Chart to display the List of values that show the allowed chart types that you 
can select and view in the specific chart view.

Figure 3–13 Modifying the Chart Type

Filters
You can change the positions shown for each dimension by making selections in the 
filters at the top of the screen above the metric tiles.
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Figure 3–14 Filters

Time Horizon
You can change the time horizon used to calculate each metric tile by changing the 
time horizon at the bottom of the screen. You can drag the start and end dates to 
impact the calculations.

Figure 3–15 Time Horizon

Recent Plans
You can view and select from a list of most recently visited workspaces by choosing a 
workspace from the Recent Plan/Workspaces section in the top right of the screen. 
This does not list all available workspaces, only the most recent. Use Refresh to 
update the list with the most recent plans.
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Figure 3–16 Recent Plans

Exception Dashboard
As a planner, you may want to see information about exceptions. You can select the 
Exception profile in the dashboard to add all the exceptions defined for the application 
as the Exception dashboard tiles. These exception dashboard tiles provide you with a 
quick summary of the exception hits. You can view the recent plans and refresh the 
dashboard.

Figure 3–17 Exception Dashboard

Exception tiles provide a summary of how many exceptional conditions exist within 
the plans you created and provide secondary information describing roughly the 
distribution of the exceptions across the data segments.

As shown in Figure 3–18, the selected alert has total of 1000 exceptions at four different 
subclasses. In the detail section under Alert Inventory Validation Count you can see 
four different graphs, one for each subclass with locations as the legend.
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Figure 3–18 Exception Tile Summary

The detail pane associated with an Exception Tile provide a more granular description 
of the location of exceptions and leverages dashboard filtering to allow you to direct 
the sequence in which to visit the exceptions. 

In Figure 3–19, the Long Sleeve Sweaters subclass has 568 exceptions across several 
location that are displayed in the graph legend.

Figure 3–19 Example Sweater Exceptions

As shown in Figure 3–20, the selected alert has total 1000 exceptions at 12 different 
locations. You can see in the detail section graph for Alert Count by Location with 
legend as the subclass. 
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Figure 3–20 Example Exception Summary

You can also contextually launch the workspaces with the selected alert. By clicking 
Open in Workspace you can open an existing segment in alert navigation mode.

Figure 3–21 Select Alert

The selected workspace is launched in alert navigation mode to guide you through the 
alerts in order to resolve the exceptions one by one. See Chapter 12, "Real Time Alerts" 
for more information on alert navigation.
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Figure 3–22 Resolve Exceptions
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When you use an RPASCE solution, you can interact with the solution through a 
personal data repository called a workspace. A workspace contains a segment of the 
data (and metadata) from the domain, and its scope is constrained by the access rights 
available to you. Workspaces are stored on the RPASCE server and can be built using 
an online wizard process or via an automatic batch process.

Pivot Table
When you are working with a workspace, the pivot table is the main area that displays 
the data in rows and columns.

Figure 4–1 Pivot Table

Sorting and Filtering
Sorting and finding data is essential when working with workspaces that contain 
thousands of items and hundreds of locations across calendar periods. Being able to 
put this data in a logical order or find a specific piece of information is what makes 
planning possible.

Sorting
You can sort positions in a level by using the arrows that appear on column headers or 
by right clicking on a cell to open the context menu. The positions are sorted based on 
the values of a measure's slice for that level. 
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The sorting occurs along a single measure, using only a single level in the sort. The 
sorting is limited to the current view, so you can see the same data sorted differently in 
different views. Sorting is only available in the pivot table, not the graph view.

Note: A slice is valid if it involves only one measure and if it has a 
unique value for each position along the level being sorted (that is, 
one position along all other dimensions in the measure's intersection 
has been selected).

Simple sorting cannot be applied to positions in a dimension along the 
page axis. However, you can pivot the desired dimension to either 
row or column axes, execute the sort along the desired slice, and then 
pivot the sorted dimension back to the page axis. 

Sorting by Column Heading
To sort by the column heading, hover the mouse pointer over a column header of the 
desired valid slice of measure data to enable the sort arrow and click the arrow. 

Figure 4–2 Sort by Column Heading

Once you click the sort arrow, the selected positions are sorted according to the 
measure's values in the selected slice. The arrow sorts in ascending order the first time 
you click it, then in descending order on the next click; it switches back and forth for 
each new click. The arrow displayed in the column header shows the current sort 
order.

An ascending sort orders the data so that the lowest number appears at the top of the 
list and the highest number appears at the bottom of the list.
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Figure 4–3 Ascending Order

A descending sort orders the data so that the highest number appears at the top of the 
list and the lowest number appears at the bottom of the list.

Figure 4–4 Descending Order

Select Position
In the z axis, you can use the Select Position button to find a position instead of 
scrolling to the desired position.

Click the dimension tile you want to be active for the Select Position action. In this 
example, you can choose from Location or Product. Whichever dimension is selected, 
Select Position will open for that dimension.
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Figure 4–5 Active Dimension (Product)

Z Axis
The z axis appears at the top of the View area and displays the dimensions on the z 
axis according to its current position in the dimension. You can scroll through the 
positions on the z axis to move through the data you are viewing in the x and y axes in 
the pivot table. If more than one dimension is on the z axis, you can select the active 
dimension to scroll through.

In this example, Location and Product are on the z axis, and Location is the active 
dimension, so the current Location position is displayed.

Figure 4–6 Location Z Axis

Select the Product dimension to make it active; the current product position is 
displayed.
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Figure 4–7 Product Z Axis

Select the dimension you want to be active and use the scroll buttons to scroll through 
that dimension only. In this example, clicking the Next button will advance to the next 
product, but the location position will not change. Note that you must click on the 
Location dimension tile to see the current location position.

Figure 4–8 Next

Find
Use the find feature to search for words, partial words, or phrases within the row 
headers and column headers of the visible views containing pivot tables. The search 
does not include the data cells within the view. The search does not include positions 
or measures on the z-axis.

The find feature locates the phrase you are looking for, and the color of the phrase 
changes to pale blue. If the matched position is not visible because it is hidden under a 
scroll bar, the view is automatically scrolled to reveal it. The find does not match 
collapsed or hidden positions. 

The find feature can be accessible in the following ways:

■ The Find option in the Edit sub-menu of the Quick Access Toolbar menu

■ The shortcut Ctrl + Shift + F from a selected pivot table cell

■ The Find button on the Quick Access Toolbar
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Using Find via the Quick Access Toolbar Menu
To use Find via the Quick Access Toolbar menu:

1. Click Menu to slide in the Main Menu .

2. Click Edit.

3. Click Find.

Figure 4–9 Find Using the Quick Access Toolbar Menu

4. The Find panel replaces the content area of the Main Menu.

Figure 4–10 Find Panel

5. Enter the following criteria:

■ Enter the characters to search for in the Find input field.

■ If more than once view is visible, select a specific view in which to perform the 
search. By default, the most recently selected view is chosen, but an All Views 
option is available from the View drop-down list. If All Views is chosen, the 
views are searched from upper left to lower right.
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■ Narrow the search to a particular dimension using the Dimension drop-down 
list. The default is to search all dimensions. Only dimensions on the x-axis or 
y-axis are listed.

■ Select Match Case to make the search case sensitive. Leave it unselected if you 
want the search to find all text that matches your text, regardless of case.

■ Select Whole Word to search for and find the text in a whole word rather than 
a partial one. For example, if you are searching for the letter R and you select 
the Whole Word option, then the search will find the Ly Net Sales R measure, 
but it will not find the letter R within the Ly GMROI% measure.

6. When finished, click Find. 

7. Any matching results are displayed in a scrolling list below the Find input field. 
Results are grouped by view, with the upper-most and left-most view results first. 
Each result includes the measure or position label that was matched as well as the 
view and dimension of the match. Find results are capped at 250 matches. If there 
are more matches, you may need to modify your search criteria to narrow your 
search.

8. Click one of the results. 

Figure 4–11 Find Results

9. The menu and the Find panel close and the matching header scrolls into view in 
the appropriate view.

Modifying Find Criteria
To return to the Find panel, click Main Menu. If the Find panel was the most recently 
selected menu item, the Find panel will be displayed with any previously found 
results. If not, you can navigate via the Edit menu item. Click in the Find input field 
and the search criteria is displayed. Modify any find criteria and click Find; the new 
results are displayed.
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Click Reset to return the Find panel criteria to the default state. Click Cancel to close 
the Find panel. Clicking outside the Find Panel causes it to close.

Find Limitations
Find does not consider z-axis positions. However, clicking Position Tile on a z-axis 
position launches a pop-up of all positions and measures that can be selected, so you 
can find a particular position if the dimension and level are known.

Measures
Measures represent the events or measurements that are recorded; the positions in the 
dimensions provide a context for the measurement. Measures are defined based on the 
business rules set in the application. The dimensionality of a measure is configured 
through the definition of its base intersection, which is the collection of levels (one per 
appropriate dimension) defining the lowest level at which the information is stored for 
the measure. Measure names are completely configurable and typically named using a 
convention that identifies each component and the meaning of the measure.

Measures that appear in the view are based on the configuration, and only measures 
configured for a view are visible in the view. You can show, hide, or reorder the 
measures using Edit Measure. See Chapter 7, "Editing Views" section "Showing, 
Hiding, and Reordering Measures".

Cells
Your ability to edit multiple workbook cells at once and to move chunks of data in and 
out of the workbook is essential to using RPASCE efficiently and effectively. This 
section describes how to select and edit cells as well as how to cut, copy, and paste 
information into cells. It also provides details about the various tasks you can perform 
with the data in cells.

Select and Manipulate Cells
Cells or groups of cells must be selected in the pivot table before certain operations can 
be performed on them. Operations such as cutting and copying data, filling or clearing 
data cells, and displaying data in chart form are typically performed on a subset of 
cells that you must select before invoking the menu commands. 

Note: Certain cells are read-only to prevent them from being edited. 
By default, read-only cells are indicated by a gray background. Cells 
are specified as read-only during configuration. This cannot be 
changed by the user. For more information, see "Read-Only 
Measures".

Select a Single Cell
To select a single cell, click inside the cell or use the cursor keys or tab key to move 
from one cell to another. When selected, the cell becomes shaded and has a black 
outline. 

Select a Group of Contiguous Cells
To select a group of contiguous cells, do one of the following:
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■ Click a starting cell and draw adjacent cells to select them. You can drag within 
one row or column or across rows and columns to create a block of selected cells.

■ Click a cell to select it. Hold the Shift key and use the cursor keys to select adjacent 
cells.

The selected cells become shaded, while the first cell selected is also outlined in black.

Figure 4–12 Contiguous Cells

Select a Group of Non-Contiguous Cells
To select a group of non-contiguous cells, 

1. Click the first cell you want to select. The selected cell becomes shaded.

2. Hold down the Ctrl key and click the other cells you want to select. All selected 
cells become shaded.
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Figure 4–13 Select a Group Non-Contiguous Cells

Navigation Shortcuts for Editing Cells
When you are editing cells in a pivot view, you can use the navigation options listed in 
Table 4–1 to move to the next cell.

Table 4–1  Navigation Options

Action Effect

Tab or Keyboard right arrow Move to next editable cell to right

Shift + Tab or Keyboard left arrow Move to next editable cell to left

Enter or Keyboard down arrow Move to next editable cell below

Keyboard Up arrow Move to next editable cell above

When you use these options, the cell you navigate to opens in editable mode (unless 
the cell is read-only). To exit editable mode, use the Escape key. 

When you navigate to read-only cells or move to and from cells that are not in editable 
mode, you can use the cursor keys.

Note: Use the Escape key to exit Editable mode and restore the 
previous value.

Enter or Change Values in a Cell
This section provides descriptions of actions you can take to change individual values 
in the pivot table. 
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to enter another type of data into the cell, you will see an error 
message.
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Numbers
You can enter or overwrite a numeric value. Some cells may have constraints on the 
values that can be entered. If you exceed this limit, you will see an error message.

Alphanumeric Values or Plain Text
You can enter or overwrite an alphanumeric value. Text may be entered up to a 
maximum value of 4096 characters. Any text string that exceeds this length will be 
truncated to this value.

Drop-Down List Items
You can select the desired option from the drop-down list. Click the arrow and select 
an item from the drop-down list. 

Check Box (Toggle) Items
You can click the check box to change the status of the item (Yes or No; On or Off).

Date and Time Items
You can select the desired date and time. Some measures may be formatted to display 
only the date. You can only set the time when the date measure is formatted to display 
time.

Click within the cell to display the Select Date and Time pop-up. Click the appropriate 
arrow keys to change the year, month, day, hour, minute, second, and AM/PM. (The 
AM/PM option buttons are available only if the measure has been configured to use 
the 12-hour format.)

You cannot enter dates or times outside of the lower and upper bounds for the 
measure.
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Figure 4–14 Edit Cell Values

Modify Data with Cell Formulas
You can use cell formulas to modify the value of a data cell in the pivot table by 
applying an operator (+, -, *, or /) to that value. With this functionality, you can make 
changes to data values without having to manually calculate the result. To perform 
this function, click the data cell and type the operator that you want to add, subtract, 
multiply, or divide by. 

For example, suppose that a particular data cell contains the value 10.

■ Add: If you enter +10 in the cell, the value becomes 20.

■ Subtract: If you enter + -10 in the cell, the value becomes 0.

■ Multiply: If you enter *10 in the cell, the value becomes 100.

■ Divide: If you enter /10 in the cell, the value becomes 1.

■ Percentages: If you want to increase the value of a cell by 10 percent, multiply the 
value by 1.1 (enter *1.1)

Cell formulas have many applications for modifying data. Cell formulas can only be 
applied to one cell at a time, but changes made to aggregate level cells are spread 
down to lower-level cells along dimension lines. Similarly, any changes made to lower 
level cells are reflected in the aggregates of that data.

In addition to the basic math operations, you can also extend the math operations. For 
example, entering +30/2 in a cell with a value 70 will add 30 to the existing value and 
then divide the result by 2.

Using Math Formulas
In addition to the basic math operations, you can enter formulae in the cells. For 
example, entering 10+30/2 in a cell will update the cell with a value 25. 
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Entering Measure Data Using a Scaling Factor
Use the scaling factor feature to enter measure data to be scaled or factored to an 
internal value that is recognized by the server in data calculations. When you enter a 
value for a measure that has a scaling factor, the value that you enter is multiplied by 
the scaling factor to arrive at this internal value. The display of the data and the ease of 
data entry can be greatly enhanced by use of a scaling factor.

For example, suppose that you want to enter data in thousands of units. You might 
find it tedious to enter 1000, 2000, 6000, and so on. A more sensible approach is to 
enter the values 1, 2, and 6, and have the system apply a scaling factor (in this case 
1000) to the entered data. The internal values of the three affected cells are 1000, 2000, 
and 6000, and these internal values are used in required data calculations. Removing 
the zeros from the display results in a cleaner, less cumbersome view appearance. 
Scaling factors can be set in the RPASCE Configuration Tools or through the 
formatting options in RPASCE. For more information about setting scaling factors in 
the Configuration Tools, see the Oracle Retail Predictive Application Server Cloud 
Edition documentation.

To set scaling factors in RPASCE, complete the following steps:

1. Right click the measure header to invoke the contextual menu and select Format. 

Figure 4–15 Measure Header

2. The Format window is displayed.

3. In Figure 4–15, the selected measure Wp Sales R is already selected and all the 
views in the current tab are selected.
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Figure 4–16 Format

4. Enter a value in the Scale field. For example, if you enter 1000, the cell value 35 
will equal 35,000. You can also add a "k" suffix to help remind you that this is a 
scaled cell.

5. Click OK to apply the change and exit the window. Note that the values are now 
scaled by the specified scale factor.

Figure 4–17 Scale Factor

You can use the scale factor for percentages as well. Enter a scale of 0.01, if you 
want to see values displayed as percentages, so that you see 19% rather than 0.19.
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Fill Cells in a View
Your ability to edit multiple workbook cells and to easily move data in and out of the 
workbooks is essential to using RPASCE to its fullest extent. You can accomplish this 
by using the fill function. Use the fill feature to quickly populate many cells of a 
writable measure at a time. Fill is available as a menu item in the right-click context 
menu. 

To fill cells with the same value:

1. Select a source cell whose value you want to repeat in other cells. This must be the 
upper/left relative to the cells to be filled.

2. Select a continuous block of cells down and to the right from that source cell.

3. Right click one of the selected cells and select Fill from the context menu.

Figure 4–18 Fill Cell

4. The value from the source cell is copied into all the other selected cells.
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Figure 4–19 Source Cell Value

Note: If Fill is employed across multiple measures, no validation is 
performed to ensure that data types are appropriate or consistent. It is 
best to only fill within a single measure.

Modifying Cell Data
In the view, you can make changes to the data cells. You can make the edits by directly 
typing or updating a value in the cell, copying and pasting, or using fill. You can also 
lock a cell value to ensure that any calculation performed during the cell edits do not 
affect the locked cell values.

After you enter or change the value in the cell, you can navigate to any other cell by 
double-clicking on that cell or using the following keyboard keys to navigate:

■ Enter to scroll down

■ Shift + Enter to scroll up

■ Tab to scroll right

■ Shift + Tab to scroll left

To learn how to modify data with math formulas, see "Modify Data with Cell 
Formulas".

Locking and Unlocking
When you change a value in a one cell, it can impact other cells, measures, or 
positions. For example, increasing the value of week 1 Regular Sales in January will 
also increase the value of the Month Total for January, but will not impact the other 
weeks in January. In addition to read-only workspaces and measures, RPASCE also 
provides a locking function in order to protect information. The locking function can 
be used on cells, measures, and positions. To continue with the above example, if you 
lock the Month Total for January and then increase the value of week 1 Regular Sales, 
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the January Month Total will not change because it is locked, but the other weeks of 
January will be decreased.

Cell locking is available for any editable cell and invokes protection processing.

Measure locking is available for any measure and invokes protection processing. 
When a measure is locked, all cells for that measure are locked.

Position locking is available for non-calendar dimensions and does not invoke 
protection processing. 

Note: Locks are not recognized by operations such as custom menus 
and refresh. Locks are only recognized when a workspace calculation 
is done. 

Cell Locking
Use the cell locking feature to lock one or more editable cells in the pivot table. When a 
table cell is locked, calculations performed as a result of data manipulations do not 
affect the locked data values. This functionality allows you to examine various what-if 
scenarios to determine the best course of action. 

RPASCE iterates through the selected cells by measure, then by column, then by row. 
Locked cell information is immediately transferred to the RPASCE server. The locked 
cell information is saved with the workspace, and locked cells continue to be locked 
when the workspace is reopened.

The locked status of a cell is indicated by the presence of a picture of a lock on the left 
side of the cell. After an eligible cell is locked, the system determines whether the 
remaining table cells are eligible or ineligible for locking. Any read/write cells that 
become ineligible for locking are made read-only.

You may choose to lock a data cell at any time to protect that cell from forced 
recalculations as a result of data manipulation elsewhere in the workspace.

 For example, you may want to see the effect of a change to sales value on inventory 
levels without forcing a change to receipts. Or, you may want to change a sales value 
at an aggregate level (such as month) and spread the results to only three of the four 
weeks that comprise that month. In this case, you can effectively hold the second 
week's sales value constant while spreading the aggregate-level increase among the 
remaining three weeks.

Cell Locking Example
The goal, when locking a cell, is to make it remain constant while you adjust other 
cells. In this example, the month level cell is locked, and then one of the week level 
cells is adjusted. This forces the unlocked weeks to adjust while keeping the month 
total.

1. To lock the month level cell, right click the cell and click Lock Cells.
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Figure 4–20 Lock Month Level Cell

2. Note the lock icon in the locked month level cell.

Figure 4–21 Lock Cell Lock Icon

3. Increase the first week of the month.

Figure 4–22 Increase the First Week

4. Click Calculate. Note the decrease to the other weeks of the month, while the 
month total did not change.
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Figure 4–23 Calculate

Measure Locking
Use the measure locking feature to simultaneously lock all of the cells that are 
associated with a given measure in a view. A measure can be locked or unlocked when 
the header cell of the measure dimension is selected. As with individual cell locking, 
the locked status of each cell in the measure is indicated by the lock picture on the left 
side of each cell.

Locked measure information is immediately transferred to the RPASCE server. The 
locked measure information is saved with the workspace, so locking measures enables 
the save features of the workspace. The locked measure information is saved with the 
workspace, and locked measures continue to be locked when the workspace is 
reopened.

If multiple measures are selected, they are locked or unlocked in row or column order. 
A measure may be locked even if it is already protected by protection processing.

Note: You can only make a selection at one level in the headers of a 
multidimensional header. Locking and unlocking apply to the selected 
measure only. Locked measures are designated by a lock icon in the 
header text of the measure and in its cells.

Measure Locking Example
The goal, in measure locking, is to lock an entire measure. If this measure is included 
in a calculation with three other measures, and this measure is locked, any change to 
the other measures will only affect the other three measures; this measure will remain 
constant.

1. To lock an entire measure, left click the header of the measure.

2. Click Menu/Edit.
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Figure 4–24 Lock Measure Edit

3. Click Lock.

Figure 4–25 Lock Measure Lock

4. The entire measure is now locked, and the lock icon appears in the header and 
each cell. If any other measures are changed, the value of this measure will not 
change, even if this measure is impacted by a calculation involving the other 
adjusted measures.
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Figure 4–26 Entire Measure Locked

Position Locking
Use position locking to lock all measures in all displayed views along one or more 
positions of non-calendar dimensions. Cells along unlocked positions are still editable 
and can also change as a result of calculations. Locked positions are designated by a 
lock icon in front of the position name. The cells of the locked position are shaded as 
read-only. 

Figure 4–27 Locked Positions

Protection processing does not run against cells locked by a position lock. Unlike cell 
locks, a parent position becomes locked if all its children are locked. A parent position 
becomes unlocked if any of its children are unlocked. Hidden children are considered 
when deciding if a parent position becomes locked. Unlocking or locking the parent 
unlocks or locks all the children. Hidden child positions are treated in the same way as 
visible children. Unlike a measure lock, the lock indicators do not show up in each of 
the cells, only in the header cells, even though the cells are displayed as read-only.

Locked position information is immediately transferred to the RPASCE server. The 
locked position information is saved with the workspace, so locking positions enable 
the save features of the workspace. The locked position information is saved with the 
workspace and locked positions continue to be locked when the workspace is 
reopened.

A position cannot be locked when locking it affects an edited or locked cell. A warning 
modal dialog is displayed and asks you to revert the affected edits and calculate the 
workspace or cancel the position locks. You are warned if a cell lock is affected and 
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given the choice of canceling the position lock or unlocking the affected cell locks and 
continuing. If both edits and cell locks are affected, then you see both dialog boxes, 
with the edit dialog box appearing first. If you cancel the position lock from either 
dialog box, then no action is taken against either locked or edited cells.

Position Locking Example
The goal, in position locking, is to lock a position so that it remains constant while you 
adjust other positions. In this example, one position in a department is locked, then the 
group total is adjusted at the higher level. This forces the unlocked departments to 
adjust while keeping the locked department unchanged.

1. To lock one of the department level positions, left click the header of the position, 
in this case the department name.

Figure 4–28 Locked Subclass

2. Click Menu/Edit. Then, click Lock.

3. The entire measure position is now locked, and the Lock icon appears in the 
header of the locked position, but not each cell.

Figure 4–29 Entire Measure Position Locked

4. Increase the group level value.
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Figure 4–30 Increase the Group Level Value

5. Click Calculate. Note that the unlocked departments increased, while the locked 
department did not change.

Figure 4–31 Calculate

Locking and Unlocking
You can initiate locks by selecting a cell, measure, or position within the pivot table 
and then selecting one of two options to initiate a lock or unlock action. You can use 
either the right click context menu or the quick access menu.

Locking Using the Right-Click Context Menu
The following locking options are available.

■ Lock Cells: locks all highlighted cells

■ Unlock Cells: unlocks all highlighted cells

■ Unlock All: unlocks all cells without the need to highlight

To lock using the right-click context menu, complete the following steps:

1. Right click the cell, measure header, or position header you want to lock. In this 
example, right click the cell. The context menu becomes visible.
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Figure 4–32 Lock Right Click

2.  Select the desired locking action (Lock Cells, Unlock Cells, or Unlock All).

Figure 4–33 Lock Action

Locking Using the Quick Access Menu
The following locking options are available.

■ Lock: locks all highlighted cells, measures, or dimensions

■ Unlock: unlocks all highlighted cells, measures, or dimensions

■ Unlock All: unlocks all cells, measures, or dimensions

To lock using the quick access menu, complete the following steps:

1. Left click the cell, measure header, or position header you want to lock. In this 
example, left click the cell.

Figure 4–34 Lock Quick Access

2. Click Menu/Edit.



Protection Processing

Workspaces 4-25

Figure 4–35 Edit

3. Select the desired locking action (Lock, Unlock, or Unlock All).

Figure 4–36 Locking Action

Protection Processing
Protection processing is the process that makes some cells within a workbook 
read-only to ensure that, during edits, no conflicts occur within the RPASCE engine in 
a calculation cycle. There are two types of protection processing.

■ Measure Protection Processing: Locks cells in all the displayed views based on 
the measures that have been edited.

■ Dimension Protection Processing: Locks cells based on the dimension 
intersections that have been edited.

Protection processing runs each time when a workbook with any locked cell or 
measure is opened, a cell is edited, a cell or measure is locked, and after each cell 
revert action. It runs only once when a group of cells is updated in one action. 
Protected cells or measures appear highlighted in a different color in the view. This is a 
configurable feature.

Measure Protection Processing
In measure protection processing, cells become read-only when you make changes to 
enough measures. This ensures that no other possible changes exist that may cause 
conflicts.

For example, consider six measures (A, B, C, D, and E) set up with the following two 
rules:

■ Rule 1 - A = B + C

■ Rule 2 - B = D + E
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In this scenario, both A and B are read-only before any edits are applied. Although B 
appears to be editable, since there are no reciprocal expressions for B's relation to D 
and E, it is not editable. Measures C, D, and E, however, are editable.

Typically, rule definitions are set up to include all equivalent derivations of any 
expression. This ensures that you can edit all of the measures contained in any 
expression in the rule.

Considering the previous example, Rules 1 and 2 can be configured as:

■ Rule 1 A=B+C, B=A-C, C=A-B

■ Rule 2 B=D+E, D=B-E, E=B-D

In this case, all measures are editable before you make any changes, and the measures 
remain editable based on the edits you make.

Measure protection processing locks all instances of a measure when any position of 
the other measures in the rule are edited. 

For example, consider the Rule 1 in a typical Product, Location, Calendar dimension. 

When you edit the measure B for product 1, location 1, and week 1 and measure C for 
product 1, location 1, and week 2, the measure A becomes read-only for all products at 
all locations in every week

Dimension Protection Processing
Changes to cells at the aggregated levels occur during a spread action that changes 
values down to the base intersection of a measure. Dimension protection processing 
protects the intersections (combination of levels) to ensure that all changes made 
during the spread do not affect such a spreading path. 

Considering the typical retail dimensions, the process applies at 
product:color-location:store-calendar:week and 
product:style-location:region-calendar:month. These two intersections are on the same 
path from the root to leaf. If the location dimension has roots for both region/state and 
store volume, any edit to a cell in the volume group dimension causes all cells 
included in an intersection with a company/region/state/city to become read-only.
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Figure 4–37 Location Dimension

Dimension protection processing changes to the intersection of dimension and level 
are processed, and edits are allowed to cells as long as the edits are on one path from 
the root to the leaf level.

Cut, Copy, and Paste
The cut, copy, and paste features provide flexibility to edit the workbook according to 
the business needs, and transfer data from external applications (such as Excel) to the 
system as well as from RPASCE to those external applications.

To apply the operation, select data from the view. After selecting the appropriate cells, 
you can cut, copy, and paste. 

Cut
Use this procedure to copy and remove data from the cells of a view in order to move 
the data to another view or other applications. Note that data created from deferred 
calculations can be cut. 

Note: You cannot cut data from non-editable, read-only, protected, or 
locked measures or cells.

To cut data, complete the following steps:

1. Select all data cells in the pivot table that you want to cut. 

2. To cut the data and copy it to the clipboard, use the shortcut command Ctrl + X)

Copy
Use this procedure to copy selected data to the application clipboard. Unlike the cut 
function, the copy function does not clear the data from the view cells. It keeps data in 
a clipboard that you can use to transfer data within RPASCE as well as to an external 
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application such as Excel. It also helps you to transfer large amount of data easily. 
When cells are copied, only the unformatted textual content is transferred. 

When data is copied from a cell to the clipboard, the string representation of the cells is 
copied to the clipboard so that it can be pasted into either other cells in the pivot table 
or to external applications. Data containing deferred calculations can also be copied. 
There is no need to invoke Calculate before copying.

To copy data, complete the following steps:

1. Select all data cells in the pivot table that you want to copy. 

Figure 4–38 Select Cells to Copy

2. To copy the data to the clipboard, use the shortcut command Ctrl + C.

Paste
After you have copied or cut data from a view, you can paste the data to other cells 
within RPASCE or you can paste it to an application such as Excel. The Paste option 
pastes the data that was last placed on the clipboard into the selected cells. 

Note: Although non-contiguous data cells can be copied, they cannot 
be pasted as non-contiguous cells. Data copied from non-contiguous 
cells does not maintain the pattern in which it was copied. For 
information about selecting non-contiguous cells, see "Select a Group 
of Non-Contiguous Cells".

To paste data, complete the following steps after you have copied or cut data from 
another location:

1. Select the cells into which you want to paste the data.

Figure 4–39 Select Cell to Paste

2. To paste the data into the cells, use the shortcut command Ctrl + V
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Figure 4–40 Paste Data

Read-Only Measures
Read-only measures are defined during the domain configuration process. The 
read-only status can be set at both the base intersection and aggregate levels. 
Read-only measures are indicated as non-editable cells based on measure information 
retrieved when the workspace is opened. 

Read-only cells by default have a gray cell background color. This same default color is 
used to indicate protection processing protected cells and elapsed cells. If the visual 
indicator for read-only is changed to be different than the visual indicator for 
protected cells and the cell is both read-only and protected, then the cell will display 
the visual indicator for protected cells. These cells are not editable.

Figure 4–41 Read-Only Measure

Workspace Operations
The majority of the work you perform within the application occurs within a personal 
workspace built around a segment. These workspaces are constructed by creating a 
copy of the subset of the applications data described by the segment and are, therefore, 
to a degree, independent from the domain and its data.

There are two reasons for the creation of workspaces within the application. First, by 
limiting the workspace to the subset of the application's data defined within a 
segment, it is possible to improve the overall performance of operations. Second, the 
workspace serves as a sandbox where you can experiment with the data without being 
concerned about the effects of those experiments on the main application data.

However, the use of workspaces by the application introduces the need to manage the 
flow of data between the domain and the workspace through a number of workspace 
operations. This section describes the operations you can perform on workspaces.
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Opening Workspaces
In order to continue working within a segment workspace, either select the segment 
from the Select Segment dialog reached from the task module or, if you have recently 
worked within that workspace, from the Recent Plans list.

Figure 4–42 Opening a Workspace

In Figure 4–42, two segments have been defined for the Create Merch Plan task. The 
segment 2020 Merch Plan is selected within the dialog with an option to open it in 
current application browser tab or a separate browser tab.

Figure 4–43 Recent Plans

Because the 2020 Merch Plan workspace has been recently used, it is also present 
within the Recent Plans section of the dashboard. Click the link highlighted in green to 
open the segment workspace in current application browser tab. Click on the link 
highlighted in red to open it in separate browser tab.
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The workspace opens in a new application tab so that you may begin working with it.

Building Workspaces
Whenever you define a segment, a workspace will automatically be created based 
upon that segment. When you create a segment using the Segment wizard, a 
workspace is built after you click Finish. This serves as the initial workspace you may 
use to work with. Additionally, it is common practice to create a regularly schedule 
that the system uses to automatically rebuild workspaces (usually in response to the 
loading of new data to the application). However, under certain circumstances, such as 
duplicating a segment, it may be possible that a segment you have defined will not 
have a workspace built and available when you wish to work in it.

Figure 4–44 Building Workspaces

In Figure 4–44, the segment 2020 Merch Plan has a workspace ready for use (as 
indicated by the blue circle) and can be opened. The segment 2020 Mens Cas cannot be 
worked in until a workspace has been built.

When this occurs, selecting a segment with no available workspace causes the system 
to build that workspace in an on-demand fashion. This on-demand workspace build 
operates like the initial workspace creation when the segment was defined and results 
in a notification when the workspace is ready to be opened. To build the 2020 Mens 
Cas segment, select it and click Build. 

Calculating Workspaces
Edits made to the cells in a view do not automatically result in updates to values 
affected by those edits. Instead, the propagation of changes to the workspace is 
deferred until an explicit action called a calculation is performed. The reasons for this 
are two-fold.

First, due to the large number of relationships between the measures in a workspace, a 
single edit might result in changes to many values. In order to prevent the application 
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from becoming unresponsive after an edit, these resulting changes are not 
immediately applied until a calculation is performed.

Second, the business logic defining how values in the workspace will update based 
upon an edit is sophisticated enough to be able to choose between multiple ways of 
updating the workspace data for a set of edits or combination of edits and cell locking, 
depending on which measures have been edited or locked.

For example, consider the relationship between total sales (the summation of regular, 
markdown, and clearance sales), markdown sales, and markdown percentage. An edit 
to total sales results in a change to markdown sales so that the markdown percentage 
remains fixed. However, if both total sales and markdown sales are edited (or if one is 
edited and the other locked), then the markdown percentage will instead be updated 
based upon the edit.

In order to allow these more sophisticated methods for propagating changes to the 
data, the system allows several edits to be entered before their effects are evaluated in 
a calculation.

Once all edits desired have been entered, a calculation can be initiated by selecting the 
Calculate item from the Edit menu.

Figure 4–45 Calculate Workspace

Click Calculate from either the menu bar above the open views or the action tray 
below it or use the Calculate accelerator hotkey (F9).

Refreshing Workspaces
When a segment is built, the workspace for that segment is initialized with the most 
current data in the application. However, after a segment has been built, its workspace 
does not automatically update to reflect changes to the application's data such as the 
loading of updated sales information. In order to incorporate the most recent changes 
to the application's data into a workspace, it is necessary to perform an operation 
called refreshing the workspace.
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When a workspace is refreshed, a rule group known as a refresh rule group is executed 
in order to perform the refresh and update the data in the workspace. This rule group 
defines which measures in the workspace must be updated to reflect changes in the 
application and in conjunction with the calculation group ensure that all measures 
derived from refreshed measures (such as variances and other Key Performance 
Indicators) are updated in response to the changing data.

Note that some workspaces, mainly those associated with some administrative 
activities, do not define a refresh rule group and, therefore, cannot be refreshed.

Figure 4–46 Refresh Workspaces

Committing Workspaces
Once a workspace has been built for a segment, all work performed is saved within 
that workspace. All edits, calculations, and actions are saved within the workspace 
sandbox but are reflected outside of the workspace. In order for the changes made 
within the workspace to be available to be an input to subsequent steps in the 
planning process or to be exported for use outside of the application, the changes 
within the workspace must be applied to the domain. This process is called 
committing the workspace. When a workspace is committed, the values contained 
within it are written back to the domain in accordance to the rules defined within the 
commit rule group.

Because the work performed within a segment workspace is saved only within that 
workspace until the commit, that work can be lost if the segment workspace is 
recycled and rebuilt without committing the workspace. It is a common practice to set 
up a schedule for performing segment rebuilds (usually to coincide with the loading of 
new data into the domain on a regular basis), so it is important for you to know the 
schedule for your organization and to plan committing workspace segments around 
this schedule to prevent the loss of your work. In order to commit a workbook, select 
Commit from the Action menu.
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Figure 4–47 Commit Workspace

Click Commit from the action tray below the view or Commit accelerator hotkey F8.

Figure 4–48 Commit

Once the workspace commit has been initiated, the system makes a copy of the current 
data within the workspace and prepares to commit that data back to the domain. In 
order to prevent data inconsistency, the system only commits a single workspace at a 
time. As a result, when multiple users are interacting with the application and 
committing segment workspaces, a delay can occur between the initiation of a 
workspace commit and its conclusion.

Once the workspace commit has completed, the system creates a notification to inform 
you that the data has been processed by the system. In the interim, you may continue 
to perform additional work within the workspace or you may move to another 
segment workspace.
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Figure 4–49 Commit Notifications

Figure 4–49 shows an example of the notification received at the conclusion of a 
segment workspace commit.

Closing Workspaces
When you are finished working in a segment workspace, you may close it by selecting 
the close icon on the application tab for the workspace. You do not need to save your 
work prior to closing the workspace, as all operations performed in the workspace 
(refreshes, calculations, commits, and so on) cause the workspace to be automatically 
saved.

Figure 4–50 Close the Workspace

Figure 4–50 shows the application tab for the open 2020 Merch Plan segment 
workspace Click the X icon on the tab to save any outstanding edits and close the 
workspace.

Note: If the browser in which the application is running is closed 
directly, edits that have not been calculated can be lost. Be sure to close 
all open segment workspaces and log out of the application prior to 
closing the browser window.
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A segment is a selection of products, locations, and times that defines a workspace. 
These selections have a name, and they last until they are deleted.

A segment is not a workspace. A segment is the positions that define a workspace and 
a key to opening the associated workspace.

Segments can be created, edited, duplicated, renamed, and deleted, and are used to 
build the associated workspace.

In an RPASCE application, segments are usually referred to by the name of the result 
of the application. For example, in Merchandise Financial Planning, a segment would 
be referred to as a plan.

Understanding the Segment Dialog Box
You can use the Segment dialog box to manage all segments for a workspace type. 
From here, you can: 

■ Filter for an existing segment

■ Create a new segment

■ Build the workspace associated with a segment

■ Edit an existing segment

■ Open an existing workspace, both in the current browser tab or in another one

■ Determine whether a given segment is associated with a workspace
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Figure 5–1 Segment Dialog Box

Figure 5–1 shows the segments that are already defined. You can create a new segment 
at any time by selecting the link in the lower left hand corner, or, when nothing is 
selected, by clicking Create New in the lower right.

The blue dot next to a segment means that the segment is active, that is, a workspace 
has already been built for that segment. This means that the workspace can be opened, 
either in this browser tab or another one.

Figure 5–2 Pre-Season Planning Active Segment

Conversely, an inactive segment, that is, one without a blue dot, must have its 
associated workspace built before that workspace can be opened.
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Figure 5–3 Pre-Season Planning Inactive Segment

In order to find a particular segment, you can sort and filter the segment entries.

To sort the entries, select an option in the Sort by drop-down list.

Figure 5–4 Pre-Season Planning Sort By List

The Sort by options are:

■ Most Recently Used: The segments are displayed in the same order as they appear 
in the Most Recently Used section of the dashboard.

■ Name (ascending): The segments are sorted in alphabetical order.

■ Name (descending): The segments are sorted in reverse alphabetical order.

■ Active: The active segments are sorted alphabetically.

■ Inactive: The inactive segments are sorted alphabetically.

To filter for a particular segment, type text into the filter box. In the Pre-Season 
Planning Filter, a single letter, s, has been entered in Figure 5–5. The list of segments 
displayed include only those with an s in the labels.
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Figure 5–5 Pre-Season Planning Filter

Creating a New Segment
A new segment can be created either with the Create New link in the lower left, or, 
when no segments are selected, by using the Create New button. In either case you are 
prompted for a label for that segment, and then taken into the wizard (see Wizards).

If you select any of the segments from the list, you no longer see the Create New 
button. Instead, the buttons Edit, Open in new tab, Open are displayed. In this case, 
you create a new segment using Create New Plank.

Figure 5–6 Create New Segment

Action Menu
In order to take action on a segment, click the Action Menu icon next to the segment. 
A context menu appears, with four options: Edit, Build, Rename, Duplicate, and 
Delete. 
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Figure 5–7 Segment Action Menu

Deleting a Segment
In order to delete a segment, select Delete from the Action menu. At the confirmation 
dialog box, click Yes to delete the segment. The workspace must be closed before it can 
be deleted.

Figure 5–8 Deleting a Segment

Note: Deleting a segment also deletes the workspace it is associated 
with. Make sure that you have finished working with the workspace 
before deleting the segment

Building a Segment
In order to build a workspace for segment, select Build from the Action 
menu/segment dialog box. The workspace begins building in the background (see 
Asynchronous Build).
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Figure 5–9 Building a Segment

Duplicating a Segment
In order to duplicate a segment, select Duplicate from the context menu. The dialog 
box prompts you for a new name and then copies the segment and displays it in the 
segment list. Any segment can be duplicated at any time.

Figure 5–10 Duplicating a Segment

Note: Duplicating a segment copies the selections that define the 
workspace, but does not make a copy of the workspace. The 
associated workspace must be created (built) before it can be used.

Editing a duplicated segment has no effect on the original segment or 
workspace.

Editing a Segment
When you select the Edit option from the context menu, the wizard opens. The wizard 
comes prepopulated with the saved selections from the segment. This option is useful 
when a new workspace must be created with the same products and locations, but for 
a different time period, such as the next week or quarter.

You cannot edit a segment when the workspace associated with the segment is open or 
being built or rebuilt. This ensures that you do not break the segment or its workspace.
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Figure 5–11 Editing a Segment

Note: Editing a segment and selecting Finish on the wizard deletes 
the existing workspace associated with the segment and recreates the 
workspace with the revised selections. Make sure you are finished 
with the workspace before editing the segment.

Renaming a Segment
When you select the Rename option from the context menu, you are prompted for a 
new segment label. After you change the label, the new label appears in the segment 
dialog and in the dashboard's most recently used list.

You cannot rename a segment when the workspace associated with the segment is 
open or being built or rebuilt. This ensures that you do not break the segment or its 
workspace. 

Figure 5–12 Renaming a Segment

Wizards
When you select Create New or Edit in the Segments dialog box, a wizard opens. The 
wizard take you through a set of screens to select the positions for each dimension in 
the workspace.   
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When you select the Edit option, the wizard is pre-populated with the saved selections 
from the segment. This option is useful when a new workspace must be created with 
the same products and locations, but for a different time period, such as next week or 
quarter.

When you select the Create New option, the wizard is not pre-populated with any 
selections from the segment.

Figure 5–13 Wizards

Level and Position Selector
To select a level or position, complete the following steps.

1. Once in the wizard, select the positions for each dimension by placing a check next 
to the position. 

You can view alternate branches of the hierarchy or dimension by using the 
Branch Selector drop-down list. When you select a different branch in the 
drop-down list, you will notice that different dimensions are displayed in the 
Levels and Dimensions area.

Note that if you select a large number of positions, it may impact the time required 
for the workspace to open. Select only the positions required for the current task.

Figure 5–14 Select Positions
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2. To select all positions, click the top of the column next to all the positions.

Figure 5–15 Select All Positions

3. To change the level of the positions to select from, place a check next to the desired 
level in the top left of the screen.

Figure 5–16 Change Position Levels

Next, Previous, Finish
Once you have made your position selections for a dimension, click Next or Previous 
to move to the next or previous dimension selection screen. If all positions for all 
dimensions have been selected, click Finish to complete the workspace build and close 
the wizard.
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Figure 5–17 Next Dimension

Asynchronous Build
Once you click Finish, the workspace begins building in the background. You can 
work on other tasks and workspaces while this is occurring. When the workspace 
build is complete, you will receive a Snackbar notification. You can also see the status 
at the bottom of the Administration Dashboard.

Figure 5–18 Asynchronous Build

When you select a workspace from the Tasks module, the Segment dialog box is 
displayed.

Figure 5–19 Asynchronous Build Notification
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6Notifications 

You can use the Notifications module to determine the status of different RPAS 
activities, such as Online Administration Tasks, segment build completions or failures, 
segment commit completions or failures, approvals and rejections, and so on.

In this way, you can continue working on other tasks while the submitted action 
occurs in background. You receive a Snackbar notification at the bottom of the screen 
when the activity status has updated for few actions. You can open a workspace by 
clicking Plan Created Notification in the Notification Panel or Notification Table in 
the Notification Tab.

You only see notifications that are addressed to you. You can further reduce the 
number of notifications by:

■ Search for a notification using the search box

■ Filter the notifications by time period, type, or severity

■ Group the notifications by type, department, or location 

Table 6–1  Notification Severity

Notification Severity

Administrative Task Completed Important

Administrative Task Failed Critical

Workspace Built Important

Workspace Build Failed Critical

Workspace Committed Normal

Workspace Commit Failed Critical

Notifications Panel
To view the Notifications panel:

1. Click Notifications on the left sidebar menu.
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Figure 6–1 Notifications

2. You can click on either the notifications icon to open the notifications dialog box. If 
launched this way, it partially covers the current workspace that you are viewing.

Figure 6–2 Notification Icon

3. If you want to continue with the work in the current workspace and 
simultaneously launch the Notifications panel, click Menu, which launches the 
notifications list by moving the current workspace.

Figure 6–3 Via Menu
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4. You can use the scroll bar to move up and down the list of notifications.

Figure 6–4 Notifications Scroll Bar

5. Click See All to see all notifications in list form. It opens a Notifications Tab.

Figure 6–5 Notifications Tab

Searching for Notifications
To search for a specific notification, enter a search term in the Search box.
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Figure 6–6 Searching for Notifications

Filtering Notifications
To filter notifications:

1. Once in the Notifications Module, click the Filters drop-down list to see the list of 
available filters. You can filter by Time Period, Type, and Severity. You can also 
click Reset to clear all filters, or click Apply to apply the filters.

Figure 6–7 Notifications Filter

2. Provide values for Time Period, Type, and Severity in the Time Period filter.
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Figure 6–8 Time Period Filter Options

3. Select a Type filter option.

Figure 6–9 Type Filter Options

4. Select a Severity filter option.

Figure 6–10 Severity Filter Options
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5. After you have selected the filter options, you can use Reset to clear the filter 
options, OK to apply the filter criteria and close the options selector, or Cancel to 
close the options selector without applying the filters.

Group Notifications
To define group notifications, complete the following steps:

1. To open the Group By dialog box, click Group View from the Notifications 
module.

Figure 6–11 Group View

You can view the group view next to the filters.

Figure 6–12 View Group View

2. To group by type, use the options Department, Class, Subclass, Location, Supplier, 
Performance, Brand, Rollup Count. and Additional Information.

3. To group by then by, use the options No Selection, Department, Class, Subclass, 
Location, Supplier, Performance, Brand, Rollup Count, and Additional 
Information. 
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Notifications Tab
When you click See All in the Notifications Drawer, it opens a Notifications tab. The 
Notifications tab lists all notifications, all unread notifications, critical, important, and 
normal notifications. You can select the desired tile to view the indicated notifications.

The actions that can be performed on the list of Notifications are Mark a notification as 
Read, Mark a Notification as Unread, Delete a Notification, and Refresh the 
Notifications list. You can perform these actions either by clicking the Actions menu 
and then the desired event or by directly clicking the shortcut buttons available.

Figure 6–13 Notifications Tab Actions

You can also Detach the Notifications list table for more visibility. Click Detach or click 
View Menu -> Detach.

Sort the notifications list by clicking View Menu -> Sort. It opens a Sort dialog box 
where you can enter Sort By, Then By and Then By to sort your notifications list. Sort 
can be performed in Ascending or Descending on each option.

Figure 6–14 Sort Notifications
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Snackbar Notifications
When an activity is started, changed, or completed, you see a Snackbar notification at 
the bottom or top right of the screen that informs you of the activity or status. 
Table 6–2 lists all Snackbar notifications.

Table 6–2  Snackbar Notifications

Notification Description

Plan creation initiated [Plan] is being prepared. You will receive a notification when 
this is complete.

Plan opened [Plan] opened.

Plan renamed [Plan] has been renamed to [Plan]

Plan deleted [Plan] has been deleted

Calculate successful Calculation complete for [Plan]

Nothing to calculate Nothing to Calculate in [Plan].

Refresh successful Refresh Complete for [Plan].

Seed successful [Plan] seeded successfully.

Seed failed [Plan] was not seeded. Contact your administrator to verify the 
seed source is valid.

Admin task submitted [Task] has been submitted. You will receive a notification when 
this is complete.

Plan tab/window closed [Plan] closed.
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You can view data in RPASCE in various ways. Changing the level, amount, and 
layout can make it easier for you to complete certain activities and tasks. For example, 
a manager might want to view data at a higher level of the product dimension, while a 
planner can work at a lower level of the dimension to complete necessary tasks. You 
make these view changes in Edit View.

Launching Edit View
To open Edit View, click any of the following places. If you click any of the dimension 
tiles in the Details tab of the Edit View window, you launch Edit View. Any other way 
launches the Setup tab of the Edit View window.

■ Edit button on the View Title Bar

■ Edit button on the dimension tiles in an open view

■ Edit button on a view tile in the View Management Drawer

■ Edit button on the Detached view

■ Adding a new view in the View Management Drawer

Figure 7–1 Launching Edit View
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Figure 7–2 Launching Edit View from the Detach View

Source
You can choose the source for the view that you want to add using the View 
Management drawer. 

Figure 7–3 Select Source in Edit View While Adding a New View

Any other way of lunching edit view except Add View displays the source as an 
uneditable field. You will not be able to change the source of a view.
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Figure 7–4 Display Source in Edit View While Editing an Existing View

Display Name
You can change the view display name using the Edit View as shown in Figure 7–5. 
You must be in the Setup tab of Edit View to complete this action.

Figure 7–5 Display Name in Edit View

View Type
You can change the view type using the Edit View as shown Figure 7–6. You must be 
in the Setup tab of Edit View to complete this action.

The following view types can be changed.

■ Pivot Table

■ Bar Chart

■ Area Chart

■ Line Chart

■ Pie Chart

■ Combination Chart

■ Line with Area Chart
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■ Funnel Chart

■ Pyramid Chart

■ Polar Chart

Figure 7–6 View Type in Edit View

Moving and Re-Ordering Dimension Tiles
To move and re-order dimension tiles, complete the following steps:

1. Once Edit View is open, click the Details tab to see the different dimensions, axes, 
levels, positions, and measures.

Figure 7–7 Edit View Details
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2. To view the contents of each axis, click the different Axis Toggle buttons in the top 
right.

Figure 7–8 Axis Toggle

3. Once you have the correct axis displayed, use the X button or the Plus button in 
the Dimension Tiles area to remove or add a dimension to that axis.

Figure 7–9 Correct Axis

4. You can also re-order the dimensions by dragging and dropping the dimension 
tiles next to another tile or swapping tiles with one another.
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Figure 7–10 Re-Order Dimensions

Changing Data Display
Use Edit View to change the data shown at each level in a view.

Branch Selection - Alternate Hierarchies
You can view alternate branches of the hierarchy or dimension by using the Branch 
Selector drop-down list. When you select a different branch in the drop-down list, you 
notice that different dimensions are in the Levels and Dimensions area.

1. Once Edit View is open, click the Details tab to see the different dimensions, axes, 
levels, positions, and measures.

Figure 7–11 Open Details Tab

2. To view the contents of each axis, click the different Axis Toggle buttons in the top 
right.
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Figure 7–12 Axis Contents

3. Click the Branch Selector drop-down list in the Levels and Positions area to see 
the different branch options (Company vs Department Group).

Figure 7–13 Branch Options (Company vs Department Group)

4. When you select a different branch, you see different dimension levels that you 
can choose from in the Levels and Positions area.

Figure 7–14 Levels and Positions
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Showing and Hiding Levels
To show or hide levels, complete the following steps:

1. Open the Details tab in Edit View.

2. Select or unselect the boxes to the left of the levels to change the visible levels.

Figure 7–15 Show Hide

3. To select all or unselect all, click the box at the top of the levels.

Figure 7–16 Top Level

4. Once the level has been selected in the left panel, click the Expand button next to 
the different positions in the right panel to expand or contract the levels.
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Figure 7–17 Expand and Collapse Levels

Displaying Individual Data
This section provides details about individual data display.

Showing and Hiding Positions
Once Edit View is open to the Details tab, you can show and hide positions in the 
view.

1. Select or unselect the boxes to the left of the positions to change the visible 
positions.

Figure 7–18 Change Visible Positions

2. To select all or unselect all, click the box at the top of the positions.
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Figure 7–19 All Positions

Measure Profiles
Measure profiles are customized groups of measures that you can create and use in 
views. Instead of adding or removing measures from the default measure list each 
time you work with a particular view, you can save that customized group of 
measures as a measure profile and load it into the view. By creating a measure profile 
for each set of measures that you frequently use, you reduce the amount of time it 
takes to set up a view. 

Measure profiles are created at the view level and are available in all views and copies 
of that view. Measure profiles are saved as part of the formatting. Depending on how 
you save the formatting, you can make your measure profiles available to other users. 
For more information, see Chapter 10, "Formatting.".

Application-Defined Measure Profiles
Application-defined measure profiles are configured with the base application and 
cannot be edited or deleted. If you make a change to the selected measures, the profile 
cannot be saved as the original profile name, but can be saved with a new name. These 
profiles are listed in the Profiles drop-down list in the Profiles section.

Figure 7–20 Application-Defined Measure Profiles
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User-Defined Measure Profiles
If you generally only work with certain measures, you can create a user-defined 
measure profile by saving a measure profile. These profiles are usually created by 
starting with an application-defined or user-defined measure profile, updating the 
selected measures as needed, and saving the measure profile with a different name. 
They are listed in the Profiles drop-down list in the My Custom Profiles section, and 
they can be deleted.

Figure 7–21 User-Defined Measure Profiles

Creating, Editing, and Deleting Measure Profiles
To create, edit, or delete a measure profile, complete the following steps:

1. Open Edit View and then go to the Measures Dimension Tile.

Figure 7–22 Measure Profile

2. To create a new measure profile, first open any of the existing measure profiles 
from the Measure Profile drop-down list.
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Figure 7–23 New Measure Profile

3. Add and remove desired measures by selecting and unselecting the measures.

Figure 7–24 Add and Remove Measures

4. Type a profile name in the Edit Profile Name text box and click Save Profile. 

Figure 7–25 Save Profile



Measure Profiles

Editing Views 7-13

Searching for a Measure
To search for a measure in Edit View, complete the following steps:

1. Click the axis that contains the Measure Dimension.

Figure 7–26 Axis Measure Dimension

2. Type into the search box in the middle of the screen. As you type, the matching 
measures is listed, and you can select and unselect the desired measures.

Figure 7–27 Search for Measure

Showing, Hiding, and Reordering Measures
Measures that appear in the view are based on the configuration, and only measures 
configured for a view are visible in the view. You can show, hide, or reorder the 
measures using Edit Measure. 

To show or hide measures, complete the following steps:

1. Click the axis that contains the Measure Dimension

2. You can show or hide particular measures by selecting or unselecting the icons 
next to each measure label, as shown in Figure 7–28.
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Figure 7–28 Icons Next to the Measure Label

3. You can also show or hide all measures by selecting or unselecting the icon in the 
header, beneath the View menu.

To reorder measures, complete the following steps:

1. Select a measure row and then drag and drop the row to a new location. In the 
following example, the measure row DAmR has been selected and then dragged 
to a new position, between BOR and DminR.

Note: Dragging a selected row near the bottom of the table causes 
the table to scroll downward while in drag mode. Dragging a selected 
row toward the top of the table scrolls the table upward while in drag 
mode.
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Figure 7–29 Reorder Measure

2. You can also select a measure row and then use the View menu to reposition the 
selected measure row. In the following example, DAmR has been selected. 
Selecting the Move Down option from the View menu causes the measure to be 
moved below DminR. Options allow you to move a selected measure row to the 
first position (absolute top of the table), bottom position (absolute bottom of the 
table), or one up or one down relative to the selected position.

Figure 7–30 Reorder View



Note: Multiple measure rows can be selected by click-dragging over 
multiple measure rows in the table or by first selecting a measure row 
and then shift-clicking to select multiple other rows or using 
Ctrl-clicking for discontinuous selections. Once multiple measure 
rows are selected, the block of rows can either be dragged and 
dropped to a new location, or the View menu can be used to 
reposition the block of rows.

Measure Profiles
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The view area includes the multidimensional pivot table or chart that displays 
information for the relevant task. Each task may include more than one view, and each 
view can appear in the contents area. The information in the view is organized based 
on the dimension positions set up at the x, y, and z axes.

RPASCE is designed to help you to work with the data within the view. You can 
manage the way the information is presented in a view. You can arrange and present 
the information in a layout the way you want by rotating or pivoting dimensions 
across the axes, changing the data roll ups, or showing or hiding measures. You can 
view the information at a low level of detail or aggregate to view the information at 
summary levels. For more information, see Chapter 7, "Editing Views.".

You can also choose to present the information in many types of charts using the 
charting functionality.

View Management Drawer
Use the View Management Drawer to select the visible views, add new views, modify 
or delete an existing view, and change the view layout. Click Manage Views to show 
or hide the View Management Drawer.

Figure 8–1 Manage Views
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Layouts
You can display one, two horizontal, two vertical, or four views at one time to help 
you complete an activity. Click the View Layout drop-down list to control the layout.

Figure 8–2 Full View

Figure 8–3 Four-Tile View
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Figure 8–4 Two Vertical View

Figure 8–5 Two Horizontal View

View List
The available views are listed on the right side of the screen in the View Management 
Drawer, as shown in Figure 8–6.
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Figure 8–6 View List

Creating a View
You can create a new view containing a new selection of measures in the form of a 
pivot table or many chart views. 

1. To create a new view, click Plus in the View Management Drawer.

Figure 8–7 Creating a View

2. In Edit View, on the Setup tab, select a Source from the drop-down list. The 
options are limited to the other existing views in the View Management Drawer.



View Management Drawer

Views 8-5

Figure 8–8 Edit View

3. Enter a Display Name. If creating a chart view, consider using a similar name to 
the source view.

Figure 8–9 Display Name

4. Select the type of view to be created, such as Pivot Table, Line Chart, Pie Chart, 
and so on.

Figure 8–10 Type of View
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5. In the Edit View dialog box, on the Details tab, you can do the following:

■ Assign dimensions to the x, y, and z axes

■ Select the levels and positions for the Calendar, Product, and Location 
Dimensions

■ Select the measures for the Measure Dimension

For more information on how to perform above steps, see Chapter 7, "Editing 
Views.".

Modifying a View
To modify a view, complete the following steps:

1. Click Edit on the View tile in the View Management Drawer.

Figure 8–11 Modifying a View

2. Follow the same steps as in "Creating a View", excluding selecting a Source. Since 
the view has already been created, the Source drop-down list is grayed out.

Figure 8–12 Edit View
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Deleting a View
To delete a view from the View Management Drawer, click Delete on the View in the 
View Management Drawer.

Figure 8–13 Deleting a View

You cannot delete the views defined in the system task flow. For such views, the Delete 
icon is disabled.

Figure 8–14 Disabled Delete Option

Working with Views
Views are associated with each step within the business workflow. Views are 
displayed as a spreadsheet-like or a chart type with the multidimensional data 
selected at the dimension levels in Edit view. Each view includes a set of measures 
relevant to the step that help you view and analyze information, and make decisions. 

View Title Bar
The View Title Bar contains the name of the view being displayed and the buttons for 
Edit, Expand, and Close. 
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Figure 8–15 View Title Bar

The Edit button opens the Edit View dialog box where you can change the view name, 
change the view type, rearrange the axes, modify the dimension levels, choose the 
measure profile, add or remove measures, hide and unhide positions, and so on. For 
more information on how to perform above steps, see Chapter 7, "Editing Views."

Figure 8–16 Edit View Dialog Box

The Expand button maximizes and detaches the view.

Figure 8–17 Maximized View
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The detached view has Edit and Collapse.

Figure 8–18 Detached View

Adding a View to a Layout
To add a view to a layout, drag the view from the View Management Drawer to a 
location on the layout. If the layout is 4 Tiled, 2 Horizontal, or 2 Vertical, you can drag 
multiple views to the different locations on the layout.

Figure 8–19 Adding a View to a Layout

Removing a View from a Layout
To remove a view from a layout, click the X in the upper right corner of the view.
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Figure 8–20 Removing a View from a Layout

Moving a View
If a view is already displayed in the layout, drag that view from the View Management 
Drawer to any different location in the layout, then left click the location to drop the 
view.

In the example shown in Figure 8–21, to move the view Local - Sales and Markdowns 
from layout location 2 to layout location 4, drag the view Local - Sales and Markdowns 
from the View Management Drawer to layout location 4.

Figure 8–21 Moving a View

Renaming a View
A view can be renamed in the Edit View dialog box.

1. Click Edit to open the Edit View dialog box.
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Figure 8–22 Renaming a View

2. Change the Display Name and click OK to rename the view.

Figure 8–23 Change the Display Name

Copying a View
To make a copy of a view, you can create a new view and use the original view as the 
source.

1. Click Plus to open Edit View.
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Figure 8–24 Copying a View

2. In the Source drop-down list, select the view to make a copy of. Complete the rest 
of the required fields.

Figure 8–25 Select View

Synchronize Z-Axis Scrolling
Synchronized Z Axis scrolling lets you simultaneously scroll through the z axis of 
multiple views. When synchronized Z Axis scrolling is enabled, all views that contain 
the same slice dimension scroll to the new slice position when one of those views is 
scrolled to a new position. When scrolling is disabled, scrolling through slice positions 
in one view does not affect the slice position display of other views.

Synchronized Z Axis scrolling works for all views within a single workspace, and it 
remains enabled as you move through the tasks and steps within that workspace. 
Synchronized Z Axis scrolling is useful when you want to compare multiple views 
containing the same page or slice dimension.

To enable synchronized Z Axis scrolling, click Synchronize Z Axis in the Z Axis and 
Dimension Tiles area, as shown in Figure 8–26 and Figure 8–27.
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Figure 8–26 Before Page Edge Synchronization

Figure 8–27 Enabling Z-Axis Synchronization

You can also Enable Synchronize Z-Axis by clicking on Menu -> View -> Synchronize 
Z-Axis, as shown in Figure 8–28.
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Figure 8–28 Synchronize Z-Axis from View Menu

You can also Disable Synchronize Z-Axis by clicking on Menu -> View -> 
De-Synchronize Z-Axis, as shown in Figure 8–29.

Figure 8–29 Desynchronize Z-Axis from View Menu
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You can use the charting feature to generate a visual representation of the data in the 
form of charts. This chapter describes the available chart types and provides 
instructions on the various tasks you can perform with charts.

Viewing Charts
If a chart view exists in the View Management Drawer, you can drag the view to the 
content area to view it. This action is similar to dragging the views from the View 
management drawer to the content area for viewing.

You can view the existing chart views in the Full View, 2-Hortizontal View, 2-Vertical 
View, or 4-View layout. You can also create a new view with View type as chart. 

 You can view the chart in the Full view mode.

Figure 9–1 Chart in Full View Mode
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Figure 9–2 Chart in 2-Horizontal View Mode

Figure 9–3 Chart in 2-Vertical View Mode

Figure 9–4 Chart in 4-Tiled View Mode
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Creating a Chart
You can create a chart for any of the existing views containing the same or different 
data. It can be helpful to have a pivot table view and a chart view open at the same 
time to make changes to the pivot table values and see the results in the chart value.

1. Click Plus in the View Management Drawer.

Figure 9–5 Creating a Chart

2. In Edit View, Select a Source and select from the existing views. This example uses 
Sales and Markdowns as the source. All data that exists in the Sales and 
Markdowns view is available in the new chart view being created.

Figure 9–6 Select a Source

3. In the Edit View dialog box, enter a name for the new view. Here, it is a name 
similar to the source.

Figure 9–7 New View Name
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4. Select the type of chart from the drop-down list.

Figure 9–8 Chart Type

5. Click the Details tab to add, remove, or rearrange any levels or positions on the 
chart and click OK.

Figure 9–9 Chart Details

6. Drag the new Chart view tile into the content area to view the chart.

Figure 9–10 Chart View Tile
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Customizing a Chart
You can customize a chart using Edit View, just like any other view. You can change 
the data representing dimension levels, change axes, measures, and so on. For more 
information, see Chapter 7, "Editing Views.".

Figure 9–11 Customize a Chart

Deleting a Chart
To delete a chart, you delete the chart view from the View Management Drawer. 
Default views cannot be deleted. 

Click Delete on the chart view in the View Management Drawer:

Figure 9–12 Deleting a Chart

Synchronize Z Axis with Charts 
It can be helpful to have a pivot table view and a chart view open at the same time to 
make changes to the pivot table values and see the results in the chart value. By 
enabling the Synchronize Z Axis button with both views displayed, you can scroll 
through positions on the Z axis, and both views will stay in synch. 
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1. In the View Layout drop-down list, select any option except for Full View. In this 
example, 2 Horizontal has been selected.

Figure 9–13 View Layout

2. Add at least two views to a layout by dragging the View Tiles from the View 
Management Drawer. In this example, the Sales and Markdowns tile and the Sales 
and Markdowns Chart tile have been dragged into the layout.

Figure 9–14 View Tiles

3. Click Synchronize Z Axis to activate it.
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Figure 9–15 Activate Synchronize Z Axis

4. The activated Synchronize Z Axis button displays in blue on both tiles.

Figure 9–16 Activate Synchronize Z Axis Button

5. Click the right arrow on the Location position in one of the views, and note that 
both views have scrolled to the same next position. In this example, the position 
has changed from Brick & Mortar to Direct for both views.
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Figure 9–17 Location Position

Chart Types
The following chart types are available:

Multi-Series
■ Bar Chart

■ Area Chart

■ Line Chart

■ Combination Chart

■ Line with Area Chart

■ Polar Chart

Single Series
■ Pie Chart

■ Funnel Chart

■ Pyramid Chart

Multi-Series Charts
A multi-series chart shows multiple series of data. Here are two examples.

■ Regular sales for ten different stores over time, where the multiple number of 
stores makes it a multi-series chart. A single series chart shows only one series of 
data.

■ Regular sales for one store over time, where one store makes it a single-series 
chart.

Bar Chart
In a Bar Chart, the data is represented as a series of vertical or horizontal bars. It can be 
used to examine trends over time or compare items at the same time (for example, 
sales for different products in different quarters).
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Figure 9–18 Bar Chart

Area Chart
In an Area chart, the data is represented as a filled-in area. An area chart can be used 
to show trends over time, such as sales for the past 12 months. Area charts require at 
least two groups of data along an axis.

Figure 9–19 Area Chart

Line Chart
In a Line Chart, the data is represented as a line, a series of data points, or data points 
connected by a line. Line Charts require data for at least two points for each member in 
a group.

Combination Chart
The Combination Chart uses three different types of data markers to display different 
kinds of data items. The Combination Chart can be used to compare bars and lines, 
bars and areas, lines and areas, or all three combinations. Combination charts require 
at least two groups of data for the chart to render an area marker or a line marker.
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Figure 9–20 Combination Chart

Line with Area Chart
Line with Area Chart is a combination of Line Chart and Area Chart. In a Line with 
Area Chart, the data is represented as a line, series of data points, or data points 
connected by a line, with a filled-in area. Line with Area Charts require data for at 
least two points for each member in a group.

Figure 9–21 Line with Area Chart

Polar Chart
A Polar Chart is a diagram in which a point of origin is surrounded by a curve whose 
radius at any given point is proportional to the magnitude of some property measured 
in the direction of that point. 
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Figure 9–22 Polar Chart

Stacked Area Chart
Area markers are stacked, and the values of each set of data are added to the values of 
previous sets. The size of the stack represents a cumulative total. This type of chart has 
the following variations.

Figure 9–23 Stacked Area Chart

Single Series Charts
A single series chart shows only one series, or set, of data. Here are two examples.

■ Regular sales for one store over time. A multiple-series chart shows multiple 
series, or sets, of data.

■ Regular sales for ten different stores over time.   

Pie Chart
In a Pie Chart, the data is represented as sections of a circle. Pie charts can be used to 
show the relationship of parts to a whole.

In Figure 9–24, because this is a single-series chart, only one quarter is shown at a time.



Chart Types

9-12 Oracle Retail Predictive Application Server Cloud Edition User Guide

Figure 9–24 Pie Chart

Funnel Chart
Funnel charts are useful for viewing data for stages of a process, such as the stages of a 
sales process. The area of a funnel slice is proportional to its value for the 
corresponding stage.

Figure 9–25 Funnel Chart

Pyramid Chart
A pyramid chart has the form of a triangle with lines dividing it into sections. Each 
section contains a related topic or idea. Because of the triangular shape, each section is 
a different width from the others; this width indicates a level of hierarchy among the 
topics. For example, the widest section may contain a general topic and the narrowest 
section may contain a much more specific topic from within that general topic. 
However, the width is not visually representative of the quantity beyond larger or 
smaller.
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Figure 9–26 Pyramid Chart

Formatting Charts
Each of the chart types has different types of formatting options. To change the chart 
format, click one of the buttons below the Dimension Tiles area. Note that not all 
formatting options work with all chart types:

■ Stacked charts help in displaying the cumulative magnitude of two or more data 
series. They are useful in representing a data value as a sum of two or more values. 
Each data series can be distinguished by the color of its section in the stack.

Figure 9–27 Stacked Chart

■ 3-D charts rotate the chart into a 3-D display.
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Figure 9–28 3-D Chart

■ The horizontal button rotates the chart from vertical to horizontal.

Figure 9–29 Horizontal Chart

■ The vertical button rotates the chart from vertical to horizontal.
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Figure 9–30 Vertical Chart

■ The Change Chart Type button allows you to quickly change the chart type to any 
of the other types not currently displayed.

Figure 9–31 Change Chart Type

Refreshing the Chart
To update the chart with the latest data from the database, click Menu->Action                       
->Refresh (Ctrl + R). This refreshes the charts and pivot tables.
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Figure 9–32 Refresh Chart



10

Formatting 10-1

10Formatting 

Using the Format functionality, you can set and clear formats that apply to measures, 
dimensions, and exceptions. You can make changes to single or multiple measures, 
dimensions, and exceptions and apply these changes across one, many, or all views in 
the workspace.

Using the Filter in the Format Dialog Box
To find measures using the filter, complete the following steps:

1. Click Menu on the Quick Access Toolbar.

Figure 10–1 Quick Access Toolbar Menu

2. Click Format to open the Format menu.



Using the Filter in the Format Dialog Box

10-2 Oracle Retail Predictive Application Server Cloud Edition User Guide

Figure 10–2 Open the Format Menu

3. Click Edit Styles and Exceptions to open the Format dialog box.

Figure 10–3 Edit Styles and Exceptions

4. You can use the filter to find measures that share a common name, type, or 
location. 

Figure 10–4 Filter Measures
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Enter data in at least one of the following fields in the Styles tab or the Exception 
tab as needed. The Styles tab is used for measure formats, and Exceptions tab is 
used for Alert condition formats.

■ Search for Measures: Enter the word or phrase you want to find. The search 
for the word or phrase is conducted throughout the entire label string, 
including any displayed attributes. This field is not case sensitive. 

■ Type: Select the type of measure you are searching for. The options are integer, 
real, date, text, Boolean, or all types.

■ Visible in: Select the view that you want to search in. You can select one, 
several, or all. 

■ Applies To: Selects the view you want to change the styles in.

Modifying Measure Styles
From the Styles tab of the Format dialog box, you can locate measures with the filter 
feature and then modify the measure style for those measures. Measures can be 
modified by altering the appearance of the headers or the cells. 

When the filter feature is not in use, the measures that appear in the Measure field 
within the Apply measure format section show the measures that are contained in the 
current view.

After you have found the measures you want to change, you can edit or clear the 
existing formats for those measures and add new ones. 

To alter the measure format, complete the following steps:

1. In the Format dialog box, select the Styles tab. Select the views that contain the 
measures in the Visible in field and Type of the measures that you want to 
change. See "Using the Filter in the Format Dialog Box" for more details.

Figure 10–5 Styles Tab

2. Use the filter to find the measures you want to alter. You can enter search text in 
the Search for measures field or select the measures in the display area by 
scrolling. You can select one, several, or all. To view only the selected measure, 
click Show Selected. To select all measures, click Select All. To clear the selection, 
click Clear.
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Figure 10–6 Alter Measure

3. In the Applies to field, select the views that you want to apply the formats to.

Figure 10–7 Applies To Field

4. Click the current selection to hide the selection panel.

Figure 10–8 Hide Selection Panel

5. You can see the summary of your selection under Measures and Views, as shown 
in Figure 10–9. Click Show More or Show Less to see the selection criteria, as 
shown in Figure 10–10. 
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Figure 10–9 Selection Measure

Figure 10–10 Selection Views

6. The Basic Formatting section includes the following options:

■ Cell Format

■ Text alignment

■ Text Format

■ Bold

■ Italics

■ Underline 

Figure 10–11 Basic Formatting

7. You can modify the basic formats as needed. To clear all styles, click Clear. 
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8. The Header Formatting section includes the following options:

■ Cell Format

■ Text Format

■ Bold

■ Italics

■ Underline 

Figure 10–12 Header Formatting

9. You can modify the header formats as needed. To revert all the changes you make 
at once, click Clear. 

10. Click Apply or Save to apply the modified basic formats. Apply applies the 
formatting, but it does not close the Format dialog box. Save applies the 
formatting and closes the Format dialog box.

Figure 10–13 Apply or Save in Format Dialog Box

11.  To close the dialog box without applying your changes, click Cancel. 
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Figure 10–14 Close the Format Dialog Box

Number Formatting
When you select integer or real type measures using the filter feature, you can modify 
the number formatting for those measures. When you are not using the filter feature, 
the measures that appear in the Measure field within the Apply measure format 
section shows the measures that are contained in the current view.

After you have found the measures you want to change, you can edit or clear the 
existing number formats for those measures and add new ones. 

To alter the number format, complete the following steps:

1. Select the measures that include number formatting. See "Using the Filter in the 
Format Dialog Box" for more details.

Figure 10–15 Number Formatting

2. The Quick Format field contains four pre-configured number formats: currency, 
percentage, thousands, and millions. If one of these formats suits your needs, 
select it. If none of the formats is appropriate, select None.

■ Currency: The currency format has a scale factor of 1 and a prefix of $. It has a 
precision of 2. For example, $1223.45.

■ Percentage: The percentage format has a scale factor of 0.01 and a suffix of %. 
It has a precision of 0. For example, 16%.

■ Thousands: The thousands format has a scale factor of 1000 and a suffix of k. 
It has a precision of 0. For example, 1,235k.

■ Millions: The millions format has a scale factor of 1000000 and a suffix of M. It 
has a precision of 0. For example, 1,235M.
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Figure 10–16 Quick Format

3. The values in the Prefix, Suffix, and Scale fields are adjusted accordingly. If the 
quick formats are not appropriate, continue to the next steps to adjust the 
remaining fields.

■ In the Prefix field, enter a string of up to seven characters that you want to 
appear before the number. Prefixes are often used for a currency symbol. 

■ In the Suffix field, enter a string of up to seven characters that you want to 
appear after the number. Suffixes are often used to denote scaling factors (k, 
m) or percentages (%).

■ In the Scale field, enter the factor to be applied to the displayed values to 
produce an internal value. For example, you can use this to display a 
fractional value as a percentage with a scale factor of 0.01.

Figure 10–17 Prefix, Suffix, and Scale Fields

4. In the Decimal Places field, enter the number of places to the right of the decimal 
to be displayed. The precision value for integers is 0. Once you have entered the 
value in the Decimal Places, you see how the formatted number appears.
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Figure 10–18 Decimal Places

5. Select Show Separator to use the thousands separator in the view. The thousands 
separator used is dependent upon the regional setting.

Figure 10–19 Show Separator

Modifying Date and Time Formats
When you select date measures with the filter feature, you can modify the date and 
time formatting for those measures. When you are not using the filter feature, the 
measures that appear in the Measure field within the Apply Date/Time format section 
show only date measures that are visible in the current view. See "Using the Filter in 
the Format Dialog Box" for more details.

To alter the Date/Time format, use the Time field to configure how the time is 
displayed. 

■ Select No Time if you do not want the time data to be displayed with the date.

■ Select 12 Hour Format to display the time in 12-hour format. Example: 10:58PM.

■ Select 24 Hour Format to display the time in 24-hour format. Example: 22:58PM.

Once you have made your selection, an example of the time format you select appears 
below the time field. 



Modifying Exceptions

10-10 Oracle Retail Predictive Application Server Cloud Edition User Guide

Figure 10–20 Time Field

Figure 10–21 Time Field

Modifying Exceptions
Exception formatting is used to set up conditions to alter certain measure styles when 
the specified condition is met. This helps you to quickly notice a cell that meets these 
conditions. Exception formatting is used for numeric measure types. Exception 
formatting defines the styles to be applied to a cell's value when it falls outside a 
defined range.

From the Exceptions tab of the Format dialog box, you can use the filter feature to 
locate measure and then modify the exception formatting for those measures. When 
you are not using the filter feature, the measures that appear in the Measure field 
within the Apply measure format section show the numeric measures that are 
contained in the current view.

Numeric Exception Formatting
To apply exception formatting, click the Exceptions tab of the Format dialog box and 
complete the following steps:

1. In the Format dialog box, select the Exceptions tab. Select the views that contain 
the measures in the Visible in field and Type of the measures that you want to 
change. See "Using the Filter in the Format Dialog Box" for more details.
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Figure 10–22 Exception Tab

2. Use the filter to find the measures you want to alter. You can enter search text in 
the Search for measures field or select the measures in the display area by 
scrolling. You can select one, several, or all. o view only the selected measure, click 
Show Selected. To select all measures, click Select All. To clear the selection, click 
Clear.

Figure 10–23 Measure to Alter

3. In the Applies to field, select the views to apply the formats to.

4. Click the current selection to hide the selection panel.

5. You can see the summary of your selection under Measures and Views. Click 
Show More or Show Less to see the selection criteria. 

6. Under the User-Defined Exceptions, depending upon the type of measure 
selection, you can add either Numeric Exceptions or Boolean Exception. 

7. For the Numeric Exceptions, click Add Condition, Use the Condition and Value 
fields to set the parameters for the exception. You can add a maximum of two 
user-defined exceptions, one for Greater Than or Equal and the other for Less 
Than or Equal.

 In the Condition field, select one these options:

■ Less Than or Equal: Use this to select values that are less than or equal to a 
value specified by the user.

■ Greater Than or Equal: Use this to select values that are greater than or equal 
to a value specified by the user.
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■ Equal:

Note: If you are entering a value that has a scale factor, such as a 
percentage, enter the raw value. For example, if you want to enter 
10%, you should enter .1. 

Exceptions applied to integer measures must have integer values. 

Figure 10–24 Condition Value

8. Under Cell Format, choose the settings you want to apply.

Figure 10–25 Cell Format

9. In the Text Format fields, choose the settings you want to apply, Bold, Italics, and 
Underline.
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Figure 10–26 Text Format

10. Preview displays how the format change appear. Click Apply to add the condition 
with format. To prioritize the alert you created over System alert, click the check 
box for Prioritize over system alert.

Figure 10–27 Apply Exception

11. Click Apply or Save to apply the formats. Apply applies the formatting, but it 
does not close the Format dialog box. Save applies the formatting and closes the 
Format dialog box.

Figure 10–28 Apply
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Boolean Exception Formatting
To apply exception formatting, click the Exceptions tab in the Format dialog box and 
complete the following steps:

1. In the Format dialog box, select the Exceptions tab. Select the views that contain 
the measures in the Visible in field and Type of the measures that you want to 
change. See "Using the Filter in the Format Dialog Box" for more details.

Figure 10–29 Exception Tab

2. Use the filter to find the measures you want to add the Exception. You can enter 
search text in the Search for measures field or select the measures in the display 
area by scrolling. You can select one, several, or all. o view only the selected 
measure, click Show Selected. To select all measures, click Select All. To clear the 
selection, click Clear.

Figure 10–30 Alert Measure
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Figure 10–31 Add User-Defined Boolean Exception

3. In the Applies to field, select the views to apply the Exception to.

Figure 10–32 Applies To Field

4. Click the current selection to hide the selection panel.

5. You can see the summary of your selection under Measures and Views. Click 
Show More or Show Less to see the selection criteria.

6. You can select the Boolean measure and under the User-Defined Exceptions, you 
see the Boolean Exception.

7. For the Boolean Exceptions, click Add Condition and use the Condition and Value 
fields to set the parameters of the exception. You can add the condition Equals and 
select the value as either True or False.

In the Condition field, select one of two options:

■ True: Use this to select values that have the Boolean flag as True.

■ False: Use this to select values that have the Boolean flag as False.
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Figure 10–33 Condition Value

8. In the Cell Format, select the settings to apply.

Figure 10–34 Cell Format

9. Preview displays how the format change appear. Click Apply to add the condition 
with format. To prioritize the alert you created over System alert, click the check 
box for Prioritize over system alert.

Figure 10–35 Apply Exception
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10. Click Apply or Save to apply the formats. Apply applies the formatting, but it 
does not close the Format dialog box. Save applies the formatting and closes the 
Format dialog box.

Figure 10–36 Apply

Saving Formats
When you make changes in Format or Edit View and click Apply or OK, the format 
changes are saved for the current workspace only. All other changes to the workspace, 
including view changes or additions, view layout changes, changes to dimension tile 
layouts on the axes, changes to visible and hidden measures, aggregation rollups, and 
so on, are saved for the current workspace automatically. The next time this current 
workspace is opened, it will retain all the changes listed here.

To apply all the listed changes to all future workspaces created for this task, use the 
Save Format functionality. The Save Format options are:

■ Only for Me: Applies the formatting to all future workspaces created for this task 
for the original the user only.

■ For My Group: Administrators - applies formatting to all future workspaces 
created for this task for all users in the same group as the original user. The last 
user to save using this option will overwrite any previous user's saves for the 
group.

When a workspace is being created, formats are applied in the following order:

1. If Save Formats/Only For Me exists for the user opening the workspace, use the 
last saved Only For Me formats.

2. If no Save Formats/Only For Me exists, use Save Formats/For My Groups: 
Administrators.

3. If no Save Formats/For My Groups: Administrators exists, use the default 
configured formats. 

Note: Save Formats only applies saved formats to newly created 
workspaces. Workspaces that are already created do not adopt these 
saved format changes

To save formats, complete the following steps:

1. On the Quick Access toolbar, click Menu and click Save Format.
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Figure 10–37 Save Format

2. Select one of the Format Level options:

■ Only for Me: Applies formatting to all future workspaces created for this task 
for only the original user.

■ For My Group: Administrators - applies formatting to all future workspaces 
created for this task for all users in the group. The last user to save using this 
option will overwrite any previous user's saves for the group.

Figure 10–38 Format Level

Deleting Formats
Delete Format has similar options to Save Format. The Delete Format options are:

■ Only for Me: If this option is used by any user, the Only for Me saved format is 
deleted for the current user only. No other users Only for Me saved format is 
deleted.

■ For My Group: Administrators - If this option is used by any user, the For My 
Group: Administrators saved format is deleted for all users in the group. It is 
possible for user A to delete this group format saved by user B.



Note: Delete Format only deletes the saved formats that apply to 
newly created workspaces. Workspaces that are already created do not 
lose any previously applied saved formats.

Deleting Formats
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To delete formats, complete the following steps:

1. On the Quick Access toolbar, click Menu and click Delete Format.

Figure 10–39 Delete Format

2. Select one of the Delete Format options:

■ Only for Me: If this option is used by any user, the Only for Me saved format 
is deleted for the current user only. No other users Only for Me saved format 
is deleted.

■ For My Group: Administrators - If this option is used by any user, the For My 
Group: Administrators saved format is deleted for all users in the group. It is 
possible for user A to delete this group format saved by user B.

Note: Delete Format only deletes the saved formats that apply to 
newly created workspaces. Workspaces that are already created do not 
lose any previously applied saved formats.
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Figure 10–40 Delete Format Options
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When you use an RPASCE solution, you can export data in the current slice of a view 
to Microsoft Excel or to a text file. You can also print it.

As part of this functionality, you can adjust the page setup options before exporting 
the data. These default settings are persisted in the RPASCE for the selected view.

The Export option is located in the Quick Access Tool Bar menu, as shown in 
Figure 11–1.

Figure 11–1 Export Option

Click Export to display the Export dialog box.
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Figure 11–2 Export Dialog Box

The export dialog box provides access to the following three tabs:

■ File Setup

■ Page Setup

■ Print Setup

File Setup
You can use the File Setup tab to specify the file name, the view that you want to 
export, file type, format type, and whether or not to include images. These options are 
described in this section.

1. Enter the file name. The exported file has this file name.

2. Select the view that you would like to export.

3. Choose the file type for the exported file. File types are either Text or Microsoft 
Excel. 

■ When you select Text, you see the options to select the Separator and the 
Description. Description has two options:

– Labels: display the labels for measures

– Names: display the names for measures 
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Figure 11–3 Text File Type

■ When you select Microsoft Excel, you have access to the options Image Size, 
Maintain Aspect Ratio, and Format Type. 

Figure 11–4 Excel File Type

4. Use Format Type to specify the way that you want the data to be exported using 
the following three options:
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Figure 11–5 Format Type

■ As Displayed: the data is exported as it appears in the Content area.

■ Formatted: the data is exported in raw format (that is, the RPASCE formatting 
has been removed) and the Excel-based formatting is automatically applied 
within Excel.

Only the formatting specified in RPASCE is applied in Excel. After the data is 
exported, you can apply more formatting within Excel.

This option is for the Text file type option.

■ Raw Data: the exported data in the text file appears without number 
formatting. 

For example, if you have entered 12588.687 and the number formatting is 
configured to have a scale of 1, a precision of 2, the separator turned on, and a 
prefix of $, the number appears as $12,588.69 in the pivot table. This number 
appears in the text file in the following ways, depending on the exported 
format type: 

– As Seen: $12588.69

– Formatted: $12,588.69 (the raw number, 12588.687, is formatted in Excel to 
display as $12588.69)

– Raw: 12588.687



Note: Data types other than integer and float are not supported. If a 
view contains columns with data types other than integer and float, 
the data is exported as it appears in RPASCE. If a workspace view 
contains a mix of columns with integer or float data types with other 
data types, the exported file contains the appropriate formatting for 
the supported data types based on the options selected during the 
export. Data in the columns of the unsupported data types appears as 
it is seen in RPASCE.

Date or any type of picklists are exported as a string.

Boolean data types are exported with formatting compatible with 
Excel.

When you use the formatted option and use a scale factor of anything 
besides 1000, the value in Excel is displayed as the raw formatted 
value, not the scaled formatted value. For percentages, a scale factor of 
.01 displays as a percent in Excel.

Note: The Separator and Descriptions options do not apply to 
Microsoft Excel exports.

File Setup
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5. By default, the Export Images check box is checked. This allows any images that 
are included in the view to be exported, along with other data. The Image URL is 
exported along with the Image format and size.

When you uncheck the Export Images check box, RPASCE does not export the   
image details.

Figure 11–6 Include Images
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6. Select the image size of the exported images from the drop-down menu. This 
option is available only for Microsoft Excel. The three available values are Default, 
Large, and Custom. 

The image size associated with the Default option and the Large option can be 
changed by the administrator. The default values are set for both the cell width 
and the cell height.

■ Default Option, the width and height specified as 100 x 100.

Figure 11–7 Default Option

■ Large option, the width and height specified as 400 x 400.
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Figure 11–8 Large Option

■ Custom option specifies a custom size within the bounds set by the 
administrator for the image cells in Excel. You can specify the width and 
height for the images.

Figure 11–9 Custom Option

7. Use the Maintain Aspect Ratio in order to maintain the actual image aspect ratio. If 
not selected, the image aspect ratio can be stretched to the specified size.



Page Setup

11-8 Oracle Retail Predictive Application Server Cloud Edition User Guide

Figure 11–10 Maintain Aspect Ratio

Page Setup
You can use the Page Setup tab to specify the page orientation, page scaling, and the 
header/footer. These options are described in this section.

Page orientation indicates the way in which a rectangular page is oriented for normal 
viewing. The two option are portrait and landscape. In Portrait mode, the page is taller 
than it is wide. In landscape mode, the page is wider than it is tall.

Page scaling has two options:

■ Adjust to is the % of Zoom to normal size. By default 100% is displayed. You can 
either adjust the value using the up and down arrow keys or type in the % value to 
zoom.
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Figure 11–11 Adjust To

■ Fit To is used to scale the document to fit the pages width and tall. By default, 1 is 
displayed. You can either use the up and down arrow keys or type in a value to 
scale the page dimensions.

Figure 11–12 Fit To

To specify the header and the footer, select Custom and add the header and the footer. 
By default, the Header and the Footer are specified as none.
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Figure 11–13 Header/Footer

Print Setup
You can use the Print Setup tab to specify the page margins, page breaks, print 
grid-lines, page order, repeat headers, and repeat column header. These options are 
described in this section.

Margin is the area between the main content of a page and the page edges. Use the 
margin to define where a line of text begins and ends. When a page is justified, the text 
is spread out to be flush with the left and right margins.

You can specify Top, Bottom, Left, and Right margins.

Figure 11–14 Margins
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If you want space between the rows, select Break Rows on. This is used to select the 
x-axis dimensions of the selected view. If more than one, then both values are shown. 

Figure 11–15 Page Breaks On

If you want space between columns, select Break Columns on. This is used to select 
the Z-axis dimensions of the selected view. If more than one, then both values are 
shown.

Figure 11–16 Break Columns On

Use the print Gridlines option if you want the gridlines to be printed.
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Figure 11–17 Print Gridlines

Use Page Order to specify either Down, then over or Over, the down.

Figure 11–18 Page Order

You can either repeat row headers every page or only on the left-most page.
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Figure 11–19 Repeat Row Headers

You can either repeat column headers every page or only on the top-most page.

Figure 11–20 Repeat Column Headers

After Setup
After you have completed file setup, page setup, and print setup, you can do the tasks 
described in this section.

If you want the exported data to be read-only, select Export as Read Only. This 
prevents the data from being updated when it is opened after the export.
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Figure 11–21 Export as Read Only

Click OK to download the view as specified and close the Export dialog box.

Figure 11–22 Download View

Click Cancel to exit the export dialog box without downloading.
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Figure 11–23 Exit Export
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12Real Time Alerts 

Real time alerts are interactive alerts that are displayed when you open a workspace or 
view. They can then be manually updated by users. Data outside of specified 
parameters is highlighted. After you have modified the data to a suitable value, click 
Calculate to clear the alert. This lets you systematically work through and clear a 
particular set of problems. The alerts are then updated each time you edit data and 
click Calculate.

Configuring Real Time Alerts
Real time alerts are configured in the RPASCE Configuration Module, which is 
normally only accessible by Administrators. This section gives a brief overview of how 
these alerts are configured. It is intended to give some background information for 
users with access to the RPASCE User Interface only.

Alert Definition
Real time alerts are configured in workspace view templates and appear in the 
workspace built using those templates. An alert definition specifies a number of 
conditions, each with styles and a message, that the alert can detect and display. Alert 
hits are determined by a designated alert measure, which uses a rule to calculate a 
condition identifier representing each hit at a designated alert intersection. These hits 
are then displayed in the cells of a designated target measure at that same intersection. 
The alert definition also contains a priority that is used when multiple alerts are raised 
on the same target measure cells.

Alert Measure
The alert measure is calculated by a rule that detects the conditions for the alert. For 
example, an alert measure FcstAlert may be computed by the following rule:

FcstAlert = if(FcstQty <=300, "tooLow", if(FcstQty >=600, "tooHigh",""))

In this example, tooLow and tooHigh are condition identifiers, which the alert 
definition associates with a style and a message. The alert measure does not have to be 
visible in any views.

Target Measure
The alert definition specifies a target measure in which the hits appear. This may be a 
measure used in the alert measure's rule, for example, FcstQty above, but does not 
have to be. When an alert measure computes a condition for a cell, the corresponding 
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target measure cell represents the alert hit and is formatted. and navigated to, 
accordingly.

The target measure cells must be visible at the alert intersection for hits to be shown. 
The target measure can be the same as the alert measure, if desired. The same measure 
may be used as the target for a number of different alerts. In the case of colliding hits, 
the alert's priority is used to determine which alert formats the cell, but the cell will be 
navigated to for any of the alerts present.

Condition Definitions
For each condition that can be produced by the alert measure's rule, a style can be 
defined. You can modify the styles via the Format dialog in Edit Styles and Exceptions. 
The styles are used to format target measure cells with the condition, and the message 
is displayed as part of the tooltip information that appears when you mouse over hit 
cells.

Working with Real Time Alerts
When you open a workspace, the real time alert hits are calculated and displayed. 
They are refreshed every time you click Calculate or invoke operations such as 
Custom Menu Executions or as part of the Commit process. 

Alerts on the Quick Access Toolbar
The toolbar contains an exception list that shows all the available alerts. Users can 
choose either all exceptions or the exceptions that are priority for resolution. The 
number beside the icon shows the number of hits for the currently active real time 
alert for the entire workbook. 

Figure 12–1 Quick Access Toolbar

Click All Exceptions and then OK to select all the exceptions for alert navigation.
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Figure 12–2 Select All Exceptions

You can either select one or multiple exceptions.

Figure 12–3 Select Multiple Exceptions

Click on the information icon to launch the alert summary of the particular selected 
alert. It displays the alerted measure, intersection, alerted condition, and format that 
was chosen to highlight the alerted cells.
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Figure 12–4 Alert Summary

Alert Navigation
Clicking on right arrow launches the alert navigation mode. Use this to navigate 
between the various alerted intersections present in the specified view. 

Figure 12–5 Alert Navigation

You can see that now you are in alert navigation mode, as highlighted in Figure 12–6.
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Figure 12–6 Alert Navigation Mode

Sometimes, a warning message indicates that the alert hits are invisible. You can check 
the alert summary to view the alert intersection and make sure that your view reflects 
the same intersection so that the alerted positions can be highlighted. 

Figure 12–7 Alert Intersections

Once the alerted intersections are highlighted in the required intersections as specified 
in alert summary, you can resolve them one by one.
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Figure 12–8 Alert Position

Click Next to move to the next selected alert until you resolve all the alerted positions. 

Figure 12–9 Moving Between Alerts

In alert navigation mode, the rows, columns, and pages in the workspace view are 
restricted to those with the currently selected real time alert. These rows are not 
dynamically updated. The same rows, columns, and pages remain visible after a 
calculation changes the data. 

You cannot change the view layout or navigate to different view in the alert navigation 
mode.
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Figure 12–10 View Layout

You can exit the alert navigation mode by clicking Done. To hide the alerts, deselect 
the Alert in the Exception list.

Figure 12–11 Exit Alert Navigation Mode

Alert Formatting
Click Format to edit styles and exceptions. The current format applied to the active 
alert, along with a summary of the calculation for the conditions, can be edited. You 
cannot add any system exceptions, as they are added in the RPASCE configuration. 
You can add any user-defined exceptions and specify the preferred format used to 
notify you and prioritize the condition over the system alert. The alert priority can be 
specified in the alert definition when multiple alerts are raised on the same target 
measure cells. You can prioritize the user-defined exception over the system exception 
also. You can also save or delete the Alert styles for you or your group.
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Figure 12–12 Alert Formatting

Addressing Alerts
After editing the data to address problems associated with a number of alerts, you can 
use the Calculate option. Once the results are recalculated, some real time alerts are 
cleared. In addition, other real time alerts may be generated.

Real Time Alerts in the Workspace
Real time alerts in the workspace are shown by highlighted cells. The highlighting 
consists of a combination of text color, background color, and font style. 

Where a view has large numbers of alerts, you can filter the alerts to choose specific 
exceptions instead of all exceptions. 

You can then systematically work to clear the real time alerts in the view by:

■ Navigating to a specific real time alert and identifying its nature from its summary 
in the alert summary.

■ Editing the value of any cell referenced by the rule to calculate the alert.

■ Clicking Calculate to update the view.

■ When you click calculate, if an appropriate value has been entered into the cell, the 
alert should clear.

You can then periodically commit the changes to save them back to the 
multidimensional database.
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This chapter describes special RPASCE features that you can use. 

Overview of What-If Scenarios
What-if scenarios are strategic method for scenario planning that a planner can use to 
make flexible plans while keeping the original scenario intact. These are additional 
plan versions that are created to simulate outcomes with different inputs. You use 
what-if scenarios to maintain and re-forecast the primary plan while preparing a 
stretch plan to quickly react to upward trends or more aggressive business growth 
targets.

You can perform what-if analysis with different KPIs and strategies from relatively 
simple, tactical decisions to the complex strategic planning. You can then promote the 
what-if scenario to be the primary plan. 

You can also see all the scenarios of the plan from the Recent Plans section of 
Dashboard.

Working with What-If Scenarios
As a planner, you make a number of decisions that affect your plans. These decisions 
can be complex and you may spend a significant amount of time developing a 
potential plan before you know if it is optimal or not. Since the workspace contains a 
single version of the plan, you cannot compare different potential approaches in the 
workspace to decide which is best.

In order to address these difficulties, RPASCE provides what-if functionality. You can 
work within the segment workspace to create a plan. You can select between 
alternative approaches and create scenarios to evaluate a potential approach. These 
scenarios provide a copy of your main plan-in-progress. While you are working on a 
scenario, the changes you make only affect the data in the scenario and do not impact 
the main plan.

In order to prevent the mixing of data from multiple scenarios, the master scenario is 
provided. When a segment is built into a workspace, the initial data set is the only one 
present and so is the master data set. As you create more scenarios, the master scenario 
remains privileged as the only version that sends commits back to the domain. After 
you develop a scenario, you select that scenario as your plan.You use a promotion 
process to replace the master scenario with the selected scenario. That scenario 
becomes the new master scenario for all future operations performed within the 
workspace.

Figure 13–1 illustrates the main scenario and the green icon that identifies it. 
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Figure 13–1 Master Scenario

You cannot delete the master scenario. Since it is already open, the Open and Open in 
new tab options are also disabled. You can either duplicate the scenario to create 
another scenario or rename the scenario.

Figure 13–2 Duplicate Scenario

Click Duplicate Scenario and enter the appropriate label, and click OK to create a new 
scenario. You cannot use an existing label from the current workspace.

Figure 13–3 Name Duplicate Scenario

The new scenario is created and you can clearly differentiate the master scenario as 
follows.
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Figure 13–4 Master Scenario Identification

Unlike the master scenario, the what-if scenarios cannot commit the data to the 
domain, as these scenarios are working copies. No action items are visible, except to 
promote the scenario to master scenario.

Figure 13–5 What-If Scenario

The actions Duplicate (to duplicate the scenario and create new one), Rename (to 
change the label of the scenario), Delete (to delete the scenario), Open (to open the 
scenario in the current browser window), and Open in new tab (to open the scenario in 
new browser tab window) are shown in Figure 13–6.
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Figure 13–6 Actions Performed on a Scenario

You can also create the scenario by using the + icon in the Scenarios section.

Figure 13–7 Create Scenario

A maximum of three scenarios is allowed, including the master scenario. Once you 
have created three scenarios and the master scenario, the + icon, Duplicate, and the 
scenario actions are disabled and you cannot create more scenarios.
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Figure 13–8 Maximum Scenarios

You can delete the scenario in order to create a new scenario. You can promote the 
scenario to master scenario. In Figure 13–9, the what-if promo 5% scenario is promoted 
to the master scenario by clicking Promote Scenario. 

Figure 13–9 Promote Scenario

After you click Promote Scenario, a snackbar notification is displayed, as shown 
Figure 13–10. Here you can either dismiss the notification or undo the promote 
scenario. If you dismiss the notification, the what-If Promo 5% scenario is promoted to 
the master scenario. If you click Undo, the what-If Promo 5% scenario is not promoted 
to the master scenario, and the earlier master scenario continues as master.
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Figure 13–10 Snackbar Notification During Promote Scenario

The what-If Promo 5% scenario is now the master scenario and you can commit the 
data by.

Figure 13–11 Promote Scenario

Viewing All Scenarios from the Dashboard
You can view all the scenarios from the recent plans section of the dashboard. 
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Figure 13–12 View Scenarios via the Dashboard

Click the down arrow under the workspace to see all the available scenarios for the 
workspace. The green icon indicates the master scenario. You can view the last opened 
date and time for the workspace.

Figure 13–13 View All Scenarios

You can either launch the workspace scenarios in the same browser or in a new 
browser tab for quick comparison.

Images
The ability to view images associated with positions on a dimension is useful in many 
aspects of the retail world such as assortment planning, item planning, and story 
boarding.

For example, you can associate an item with an image being displayed on the shelf. 
You can associate stores with images of the store front or interior. You can use images 
to storyboard themes by creating a collection of looks and colors for a particular 
buying period, floor set, or flow. Some retailers associate multiple types of images with 
multiple levels of the Product dimension. For example, you can associate images for 
product levels such as Department, Class, Subclass, Style and Style/Color.

With RPASCE, you can associate an image for any dimension with a configured media 
attribute, including calendar levels. These images can be stored on a website that must 
be declared under the safe hosts for the application to display the images.
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Overview
Images can be included in a domain by configuring media dimension attributes, 
loading them with media bundle values referring to images, and making them visible 
in worksheets. A number of images may be included in each bundle value; one of 
those is designated as the primary image that can be seen in the pivot table. All the 
images, not just the primary, can be seen via View/Manage Images.

Pivot table headers display images for visible media dimension attributes. You can see 
the primary image of the image attribute available for the given level. 

Figure 13–14 Image Display

You can right click on the Images and perform the following actions: 

■ Format: Launches the Format dialog box

■ Lock Row: Locks the whole row where the image exists

■ Unlock Row: Unlocks the whole row where the image exists

■ Unlock All: Unlocks all the rows wherever locked earlier

■ View/Manage Images: Launches the View/Manage Images dialog box

■ Hide Images: Hides the images.

Figure 13–15 Image Cell Action
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View and Manage Images
Right click on the Images to launch the View/Manage Images dialog box. You can 
view the dimension and level of the image displayed. You can search for a particular 
position by using the search box or scroll bar. You can view the image as full or 
thumbnail and the main image (default) along with any other existing images for that 
level. 

Figure 13–16 View and Manage Images

Resize Images
You can resize the image rows and columns in pivot table and see them persisted so 
that you do not have to resize them. Images should auto-scale to fit the header cell, but 
never increase beyond their native size.

Figure 13–17 Resize Image

Show or Hide Images
Right click on the Images and click Hide Images to hide the images. 
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Figure 13–18 Hide Images

In order to view images, you can click on the dimension position where images are 
enabled and click Show Images.

Figure 13–19 Show Images

You can change the axis of the dimension and the images are rearranged

Figure 13–20 Image Display with Axis Pivot
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The default No Image icon is displayed when no image is associated with the 
dimension position. If an image URL is associated but RPASCE cannot show the 
image, then the Broken Image is displayed. 

Figure 13–21 No Image Icon

Figure 13–22 Broken Image Icon

Extended Measures
You can use an extended measure to define, view, and edit a measure as a proportion 
or percentage of another measure for a parent that is up one or more levels. These 
measure relationships are also referred to as participation measures. These measures 
are defined in the pre-configured RPASCE in a view using the configuration. 

This functionality is commonly used to define measures that are percentage 
participations of sales measures. Typically, these measures are defined as:

■ Absolute Percent of Parent: A percentage of a fixed level (such as class) so that the 
participation of each item to the class can be viewed and manipulated. 

■ Relative Percent of Parent: A percentage to the next level shown in any dimension 
(such as Product). 

■ Ranking: A value that indicates the relative order of positions in either ascending 
or descending order.

■ Cumulative Sum: A sequence of partial sums of a given sequence, based on an 
ascending or descending rank. 

■ Cumulative Percent: A sequence of partial sums of a given sequence, based on an 
ascending or descending rank expressed as a percentage to the total.

Figure 13–23 Extended Measure
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Note the following:

■ Extended measures can be defined only on measures that have Total as their 
default aggregate method.

■ When the percentage of the extended measure is changed, values of the 
underlying measure change to reflect the newly set percentage.

■ Multiple extended measures can be defined for the same underlying measure; 
however, only one extended measure or the underlying measure can be edited 
before calculation. All other versions are protected.

■ Smart editing is not allowed in the extended measure.

■ Extended measures cannot be based on split dimensions.

■ The value of an extended measure is a fraction between zero and one. If desired, 
you must format the measure to be displayed as a percentage.

■ For extended measures contributions in instances with very small values (such as 
0.000001) in the cell, those values are considered to be 0.0 when the extended 
measures contribution is determined.

■ For Ranking, Cumulative Sum, and Cumulative Percent, the extended measures 
are read only.


	Contents
	Send Us Your Comments
	Preface
	Audience
	Documentation Accessibility
	Related Documents
	Customer Support
	Improved Process for Oracle Retail Documentation Corrections
	Oracle Retail Documentation on the Oracle Technology Network
	Conventions

	1 Getting Started
	Overview
	Essential Concepts
	Multidimensionality
	Dimensions, Levels, and Positions
	Measures
	Cells
	Workspaces and Domains
	Dashboard
	Dynamic Hierarchy

	Setting Up Your Browser
	Cache Settings
	Security Settings
	Logging Into RPASCE
	Logging in Using Single Sign-On
	Concurrent Sessions
	Comparative Analysis

	Understanding the Taskflow
	Access-Based Visibility
	Switching Between Multiple Tasks

	Workspace Operations
	Locating the Version Number
	Accessing Online Help
	Logging Out of the Application


	2 User Interface
	Left Sidebar Menu
	Task Module
	Notifications
	Reports

	Mega Menu
	Help

	Quick Access Toolbar
	Menu
	Action Menu
	Edit Menu Options
	View Menu
	Format Menu

	Calculate Button
	Find Button
	Export Button
	Real Time Alerts Exceptions List
	Text Size
	Manage Views

	Content Area
	Page Edge and Dimension Tiles Area
	Pivoting and Rotating Dimensions
	Paging and Position Navigation
	Edit View
	Synchronize Z Axis Scrolling


	View Management Drawer
	Action Tray

	3 Dashboards
	Tiles
	Adding a New Tile
	Changing the Display Order
	Removing a Tile

	Main Chart
	Modifying the Chart Type
	Filters
	Time Horizon
	Recent Plans
	Exception Dashboard

	4 Workspaces
	Pivot Table
	Sorting and Filtering
	Sorting
	Sorting by Column Heading

	Select Position
	Z Axis

	Find
	Using Find via the Quick Access Toolbar Menu
	Modifying Find Criteria
	Find Limitations

	Measures
	Cells
	Select and Manipulate Cells
	Select a Single Cell
	Select a Group of Contiguous Cells
	Select a Group of Non-Contiguous Cells

	Navigation Shortcuts for Editing Cells
	Enter or Change Values in a Cell
	Numbers
	Alphanumeric Values or Plain Text
	Drop-Down List Items
	Check Box (Toggle) Items
	Date and Time Items

	Modify Data with Cell Formulas
	Using Math Formulas
	Entering Measure Data Using a Scaling Factor
	Fill Cells in a View
	Modifying Cell Data

	Locking and Unlocking
	Cell Locking
	Cell Locking Example

	Measure Locking
	Measure Locking Example

	Position Locking
	Position Locking Example

	Locking and Unlocking
	Locking Using the Right-Click Context Menu
	Locking Using the Quick Access Menu


	Protection Processing
	Measure Protection Processing
	Dimension Protection Processing

	Cut, Copy, and Paste
	Cut
	Copy
	Paste
	Read-Only Measures

	Workspace Operations
	Opening Workspaces
	Building Workspaces
	Calculating Workspaces
	Refreshing Workspaces
	Committing Workspaces
	Closing Workspaces


	5 Segments
	Understanding the Segment Dialog Box
	Creating a New Segment
	Action Menu
	Deleting a Segment
	Building a Segment
	Duplicating a Segment
	Editing a Segment
	Renaming a Segment

	Wizards
	Level and Position Selector
	Next, Previous, Finish
	Asynchronous Build


	6 Notifications
	Notifications Panel
	Searching for Notifications
	Filtering Notifications
	Group Notifications
	Notifications Tab
	Snackbar Notifications

	7 Editing Views
	Launching Edit View
	Source
	Display Name
	View Type
	Moving and Re-Ordering Dimension Tiles

	Changing Data Display
	Branch Selection - Alternate Hierarchies
	Showing and Hiding Levels

	Displaying Individual Data
	Showing and Hiding Positions

	Measure Profiles
	Application-Defined Measure Profiles
	User-Defined Measure Profiles
	Creating, Editing, and Deleting Measure Profiles
	Searching for a Measure

	Showing, Hiding, and Reordering Measures


	8 Views
	View Management Drawer
	Layouts
	View List
	Creating a View
	Modifying a View
	Deleting a View

	Working with Views
	View Title Bar
	Adding a View to a Layout
	Removing a View from a Layout
	Moving a View
	Renaming a View
	Copying a View

	Synchronize Z-Axis Scrolling

	9 Charts
	Viewing Charts
	Creating a Chart
	Customizing a Chart
	Deleting a Chart
	Synchronize Z Axis with Charts
	Chart Types
	Multi-Series Charts
	Bar Chart
	Area Chart
	Line Chart
	Combination Chart
	Line with Area Chart
	Polar Chart
	Stacked Area Chart

	Single Series Charts
	Pie Chart
	Funnel Chart
	Pyramid Chart


	Formatting Charts
	Refreshing the Chart

	10 Formatting
	Using the Filter in the Format Dialog Box
	Modifying Measure Styles
	Number Formatting
	Modifying Date and Time Formats
	Modifying Exceptions
	Numeric Exception Formatting
	Boolean Exception Formatting

	Saving Formats
	Deleting Formats

	11 Export
	File Setup
	Page Setup
	Print Setup
	After Setup

	12 Real Time Alerts
	Configuring Real Time Alerts
	Alert Definition
	Alert Measure
	Target Measure
	Condition Definitions

	Working with Real Time Alerts
	Alerts on the Quick Access Toolbar
	Alert Navigation
	Alert Formatting
	Addressing Alerts
	Real Time Alerts in the Workspace


	13 Special Features
	Overview of What-If Scenarios
	Working with What-If Scenarios
	Viewing All Scenarios from the Dashboard
	Images
	Overview
	View and Manage Images
	Resize Images
	Show or Hide Images

	Extended Measures


